Step by Step Guide for GIS Cloud Applications

All in one manual for:

Map Editor
Map Viewer
Asset Data Collection and Management
Fleet Management
Roadwork Management and Coordination
Mobile Data Collection
Publisher for ArcMap
# Table of Contents

Introducing GIS Cloud.................................................................................................................. 1
Why GIS Cloud? ............................................................................................................................. 3
GIS Cloud Technology .................................................................................................................. 4

Map Editor Manual ..................................................................................................................... 5
Introducing Map Editor ................................................................................................................ 5
My Account ..................................................................................................................................... 7
Getting Started ............................................................................................................................. 10
  Main User Interface .................................................................................................................... 10
  Creating A New Map .................................................................................................................. 17
Import and Export Data .................................................................................................................. 20
  Upload Data ............................................................................................................................... 20
  Drag & Drop ............................................................................................................................... 22
  Web to Cloud Upload ............................................................................................................... 23
  Import CSV or XLS .................................................................................................................... 24
  Adding Layers ......................................................................................................................... 27
  Layer and Map Exporting ....................................................................................................... 35
Layer Properties ........................................................................................................................... 37
  Classification By Attributes ..................................................................................................... 38
  Appearance Settings ............................................................................................................... 42
  Display Settings ....................................................................................................................... 45
  Attributes Settings ................................................................................................................. 46
  Labels ......................................................................................................................................... 47
Creating and Editing Layers ......................................................................................................... 49
  Create and Edit Point Layer ................................................................................................. 50
  Create and Edit Polygon Layer ............................................................................................. 52
  Create and Edit Line Layer ................................................................................................. 54
  Create Mobile Layer .............................................................................................................. 56
  Edit Attribute Data ............................................................................................................... 57
  Other Edit Features .............................................................................................................. 58
Selecting Layers and Objects ......................................................................................................... 60
  Select Layer and Identify Tool ............................................................................................... 60
  Multiselect Methods ............................................................................................................... 61
  Invert Selection Tool .............................................................................................................. 63
  Creating a New Layer from Selection ................................................................................... 64
  Spatial Selection ..................................................................................................................... 65
GIS Analysis .................................................................................................................................. 68
  Area Analysis ......................................................................................................................... 68
  Buffer Analysis ....................................................................................................................... 69
  Two Layer Comparison .......................................................................................................... 71
  Hotspot analysis ..................................................................................................................... 72
  Radius Coverage .................................................................................................................... 73
Tools Tab ....................................................................................................................................... 75
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Manager</td>
<td>75</td>
</tr>
<tr>
<td>Database Manager</td>
<td>76</td>
</tr>
<tr>
<td>Projection Wizard</td>
<td>78</td>
</tr>
<tr>
<td>Merge Wizard</td>
<td>79</td>
</tr>
<tr>
<td>Geocoder</td>
<td>80</td>
</tr>
<tr>
<td>Sharing and Publishing</td>
<td></td>
</tr>
<tr>
<td>Map Sharing</td>
<td>83</td>
</tr>
<tr>
<td>Set Layer Permissions</td>
<td>84</td>
</tr>
<tr>
<td>Embedding Maps into a Web Page</td>
<td>85</td>
</tr>
<tr>
<td>Web Map Service - WMS</td>
<td>86</td>
</tr>
<tr>
<td>Tutorials</td>
<td>87</td>
</tr>
<tr>
<td>Tutorial 1: Upload, prepare and add data</td>
<td>87</td>
</tr>
<tr>
<td>Tutorial 2: Geocode your data</td>
<td>91</td>
</tr>
<tr>
<td>Tutorial 3: Classification and appearance settings</td>
<td>95</td>
</tr>
<tr>
<td>Map Viewer Manual</td>
<td>101</td>
</tr>
<tr>
<td>Introducing Map Viewer</td>
<td>101</td>
</tr>
<tr>
<td>My Account</td>
<td>102</td>
</tr>
<tr>
<td>Main User Interface</td>
<td>104</td>
</tr>
<tr>
<td>Selecting Layers and Objects</td>
<td></td>
</tr>
<tr>
<td>Select Layer and Identify Tool</td>
<td>110</td>
</tr>
<tr>
<td>Multiselect Methods</td>
<td>111</td>
</tr>
<tr>
<td>Spatial Selection</td>
<td>112</td>
</tr>
<tr>
<td>Layer and Map Exporting</td>
<td></td>
</tr>
<tr>
<td>Layer Exporting</td>
<td>115</td>
</tr>
<tr>
<td>Map Exporting</td>
<td>115</td>
</tr>
<tr>
<td>Asset Data Collection and Management Manual</td>
<td>117</td>
</tr>
<tr>
<td>Introducing Asset Data Collection and Management</td>
<td>117</td>
</tr>
<tr>
<td>My Account</td>
<td>119</td>
</tr>
<tr>
<td>Main User Interface</td>
<td>121</td>
</tr>
<tr>
<td>How Does It Work?</td>
<td>126</td>
</tr>
<tr>
<td>Add and Associate Mobile Devices</td>
<td>126</td>
</tr>
<tr>
<td>Collect Data</td>
<td>127</td>
</tr>
<tr>
<td>Process Data</td>
<td>128</td>
</tr>
<tr>
<td>Create Detailed Reports</td>
<td>129</td>
</tr>
<tr>
<td>Create Work Orders</td>
<td>130</td>
</tr>
<tr>
<td>Advanced Options</td>
<td>132</td>
</tr>
<tr>
<td>Connect to the Map Editor</td>
<td>132</td>
</tr>
<tr>
<td>Integrate with the Roadwork Management and Coordination</td>
<td>133</td>
</tr>
<tr>
<td>Integrate with the Fleet Management</td>
<td>134</td>
</tr>
<tr>
<td>Tutorial: Get started</td>
<td>135</td>
</tr>
<tr>
<td>Fleet Management Manual</td>
<td>138</td>
</tr>
<tr>
<td>Introducing Fleet Management</td>
<td>138</td>
</tr>
<tr>
<td>My Account</td>
<td>140</td>
</tr>
<tr>
<td>Main User Interface</td>
<td>142</td>
</tr>
</tbody>
</table>
Manage Your Fleet ................................................................................................................... 147
Administer Your User Accounts .......................................................................................... 147
Define Settings ..................................................................................................................... 148
Review Info .......................................................................................................................... 149
Queries and Graph Analysis ................................................................................................. 150
Create Reports ...................................................................................................................... 151
Advanced Options .................................................................................................................... 155
Driver to Driver & Dispatcher Communication ................................................................... 155
Automatic Tasks and Routing .............................................................................................. 156
Connect to the Map Editor ................................................................................................... 157

Roadwork Management and Coordination Manual ............................................................... 159
Introducing Roadwork Management and Coordination ....................................................... 159
My Account .............................................................................................................................. 161
Main User Interface .................................................................................................................. 163
How Does It Work? .................................................................................................................. 167
  Create Custom Forms and Tables ........................................................................................ 168
  Enter a Construction ............................................................................................................. 169
  Timeline analysis .................................................................................................................. 170
  Create Detailed Reports ....................................................................................................... 172
  Print Related Documents ...................................................................................................... 172
Advanced Options .................................................................................................................... 174
  Connect to the Map Editor ................................................................................................... 174
  Integrate with the Asset Data Collection and Management ................................................. 176
  Integrate with the Fleet Management ................................................................................... 176
  Connect with the Mobile Data Collection app ..................................................................... 177
Tutorial: Get started ................................................................................................................. 178

Mobile Data Collection ........................................................................................................ 184
  How to use Mobile Data Collection app .................................................................................. 185

Publisher for ArcMap .............................................................................................................. 186

FAQ ........................................................................................................................................ 188
  GIS Cloud Applications ........................................................................................................ 188
  Sign Up and Accounts ......................................................................................................... 189
  Map Editor ............................................................................................................................ 190
  Map Viewer .......................................................................................................................... 192
  Asset Data Collection and Management ............................................................................. 193
  Roadwork Data Management and Coordination ................................................................. 194
  Fleet Management ................................................................................................................ 196
  Mobile Data Collection ........................................................................................................ 197
  GIS Cloud Publisher ............................................................................................................. 198
Introducing GIS Cloud

What is a Geographic Information System (GIS)?

There are many definitions for GIS, in the simplest terms, GIS is the merging of cartography, statistical analysis, and database technology. Many have expressed that GIS integrates hardware, software, and data for capturing, managing, analyzing and publishing all forms of geographically referenced information. Still others have said that GIS is a technological field that incorporates geographical features with tabular data in order to map, analyze, and assess real-world problems. Whatever the many various definitions are, you will find that GIS Cloud is a software platform that will allow you to efficiently and with great ease implement the very best that GIS technology has to offer.

What is GIS Cloud?

GIS Cloud is the first purely web based GIS powered by cloud computing. It provides full desktop GIS features enriched by the web. GIS Cloud offers easy and efficient visualization, analysis and exploration of geographic information. The primary goals of the GIS Cloud platform are as follows; to simplify exchange of geographical information between users and offer an easy way to analyze this information regardless of the location of its users. By using GIS Cloud our users access the full power of desktop GIS, allowing for such activities as geospatial analysis, spatial intelligence, the creation of customized mapping reports and publishing geographic analysis on the Web.

What can you do with GIS Cloud?

With GIS Cloud you can create a very wide range of GIS projects and analyses. Shown below are just a few of the many possibilities.

A Department of Geodesy enlists cadastre data and land registry information to improve land management, increase work efficiency and quality of service.
A telecommunication company carries out the analysis of lines and stations to gauge their effect on the environment.

A City Water department has developed a GIS for water utility infrastructure to improve management and distribution of water. This has also had a large effect on the efficiency of emergency interventions and maintenance.

A Croatian fire department has created and implemented fire hydrant maps in the city area to improve emergency response. The comprehensive database encompasses vital information regarding functional and non-functional fire hydrants.
A city has a need to plan for increasing traffic pressures due to an expanding airport. In doing so they are able to identify those areas with a need to reduce noise and pollution.

**Why GIS Cloud?**

**Cost efficiency**

When compared to traditional GIS software, GIS Cloud provides users with a service they can use in a simpler and more affordable way. Before the cloud was widely available, GIS was the privilege of companies that could afford high up-front investments in powerful hardware, high maintenance costs and expensive software licenses.

**Easy web publishing**

Traditional GIS requires separate pieces of software for desktop and web based operations, and often third party tools as well. To make web publishing or creating web GIS applications easier, GIS Cloud has been designed as all-in-one web solution. Create, edit, analyze and publish data from only one GIS service and, even more importantly, do it simply.

**Improved GIS collaboration**

Companies that have a large number of employees across offices, in remote branches, or off-site, can find collaboration in the traditional GIS environment quite difficult. Imagine working on a project assigned to teams spread across several departments as well as an off-site team collecting data.
GIS platform and integration

GIS Cloud talks to others! The GIS Cloud API is an efficient way to integrate with other systems, or develop new features that fit your specific needs; this allows you to create rich, interactive, stand-alone web mapping applications.

Cloud security

Centralized systems such as GIS Cloud, with encrypted disk partitions and the encrypted client connections, have facilities to be a much safer environment for confidential data than traditional GIS systems.

GIS Cloud Technology

GIS Cloud’s main differentiating characteristic is its unique vector visualization engine because it provides a full desktop-like GIS experience in any browser. This improves usability, appearance, mapping experience in a way that other map engines (using raster technology) cannot. The wide range of supported vector and raster file and database formats make it possible to use GIS Cloud alongside other GIS solutions (on the desktop and on the web). The cloud provides a reliable, secure and highly available infrastructure which is under constant supervision and management from our team. Finally you can focus more on GIS and less on patching, tuning, upgrading and updating various pieces of GIS software and hardware.
Map Editor Manual

This manual will allow users to easily navigate through the Map Editor user interface. The manual illustrates the functionality, options and methods required to leverage the power of the GIS Cloud platform. For those new to GIS, this manual will also serve as an excellent primer for GIS.

Introducing Map Editor

What is Map Editor?

GIS Cloud’s Map Editor is a powerful cloud based map editor that enables you to easily build and share your maps. It supports number of vector and raster formats, rich GIS symbology and it has built-in collaboration capabilities. Developed on the latest HTML5 technologies, it is the first of its kind application with full vector-based editing and real-time updates to the geo database.
Why Map Editor?

Map Authoring

- Create and edit maps, layers and features (points, lines and polygons)
- Rich GIS symbology with customizable rules (expressions), thematic map wizards and powerful label management
- Supports multiple vector and raster formats (.shp, .kml, .gpx, .tif, .sid, ...)
- Edit spatial and non-spatial data

Data Sources & Management

- Upload and sync data (files, DB, API)
- Supporting multiple sources: vectors, rasters, WMS, ESRI ArcMap, Basemaps (Google Maps, Bing), Mobile devices, MapBox, PostgreSQL, Excel, CSV, ...
- File and database manager
- Tabular and window pop-up for non-spatial data view with attribute aliases, filtering and re-ordering

Sharing

- One-click map sharing with other GIS Cloud users
- Share with view or edit capabilities
- Share over permalink
- Per layer sharing permission settings

Publishing and Export

- Easily publish your maps through the embed code, WMS and Google Maps
- Customize and integrate using the API
- Export maps to high resolution raster imager
- Export vector layers to spatial vector formats (.shp, .mif, .kml, ...)
- Print

Spatial Queries & Analysis

- Do hotspot, buffer, area & radius coverage analysis
- Write complex spatial selection expressions using spatial selection wizard
- Create new layers from a selection
My Account

Before you get started you have to create a new account through our sign up form. In addition to our regular sign in form, you have the option to sign in instantly with the social network you use.

Create a new account:

Username
Email
Password
Confirm Password

... or sign up instantly with:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Google</td>
<td>Facebook</td>
</tr>
</tbody>
</table>

Already have an account?

Username
Password

Forgot your password?
The My Account dialog allows you to edit your personal information, login information and manage API keys.
Getting Started

Before you start to create, upload, author, publish and share your spatial data in the Cloud you have to get acquainted with the basics. In this section you can find information about Map Editor user interface and how to create a new map.

Main User Interface

When you begin to use GIS Cloud you must first get acquainted with the user interface. It is a part of platform which offers complete oversight of projects, as well as functionality for working with the geospatial data itself.

In this manual, we have placed a red number over each pictured interface; that number corresponds to the instructions for each product feature.

1. **Login and My Account** – You need to log in using your User Name and Password to access Map Editor. After that you will be able to use the application fully. After logging in, you will be able to modify your user account.

2. **Tool Ribbon** – Here we offer complete access to the application’s features: creating projects and maps, adding layers as well as conducting your analysis and performing data management. The tabs above the ribbon reveal additional tools. Tool Ribbon functions are described in the separate chapter Tool Ribbon.
3. **Toolbar** – Provides the tools needed for basic operations with maps. Toolbar functions are described in the separate chapter Toolbar.

4. **Project Name bar** – Displays the project name as a link. You can send someone a link to the map by using the address that the link points to, or you can refresh the map by clicking on the link.

5. **Layer panel** – A "table of contents" type of display for the active project. The layer panel offers the following functionality:
   - Drag and drop ordering - Control layer display order
   - Lock layers - Prevent editing and deletion.
   - Layer visibility – Toggles the display of the selected layer.
   - Transparency (bottom) - Transparency of the selected layer increases as slider is moved to the left.
   - Toolbar - Buttons include the following functions for the selected layer:
     - Add
     - Edit (see Creating and Editing Layers section)
     - Create folder
     - Delete selected layer
     - Rename selected layer
     - Zoom to selected layer extent

7. **Map Viewer** – Map display of visible layers and cartographic features.

8. **Layer Data Table** – Table displaying all attribute records and fields of a selected dataset.

9. **Info Table and Search tool** - View info about selected feature and search for specific features.

For better viewing experience we've implemented an option to hide tool ribbon and layer panel. The red dots (on picture below) mark positions of the sliders where you can toggle the ribbon, the layer panel and the info panel (hidden by default) on and off.
Home Tab

The Home tab is a centralized place to access all maps you have access to - your own maps, maps someone has shared with you, or public maps. The menu on the left (1) provides not only easy access to all of your maps, but easy discovery of and access to new maps and data. You can browse available maps by directories, search for maps or just go for the recently open maps. The gallery (2) provides easy access to all of the maps available to your user account, whether the maps are created by you, shared with you or publicly visible.

![Home Tab Image](image.png)

Toolbar

The tools and their functions are:

1. **Pan** - Enables the user to interactively move the Map View position.
2. **Zoom** - Left click and drag a rectangular box on the map to define the desired view extent. Zooming can also be achieved by a mouse scroll or by using the slider to the left.
3. **Zoom to Full Map Extent**
4. **Select** - Selects a single feature in an active layer. More about the Select tool can be found in the chapter Selecting Layers and Objects.
5. **Identify** - Identifies an element on the map and shows its attribute information.
6. **Area Selection** - Clicking and dragging a rectangular box with the mouse creates a selected set of features from an active layer. More about the Select tool in the chapter "Selecting Layers and Objects".

7. **Measuring Tool** - Interactive display of distances on the Map View. Left clicking will allow distance display over multiple vertices.

8. **Print** - Any created map can be printed.

9. **Scale**

10. **Jump to Coordinates** - Zoom to a set of coordinates – The current coordinates of the mouse cursor are displayed. To define specific coordinates and have the view zoom to the specified position, left click; enter coordinate information.

11. **Number of Selected Objects on the Map**

**Tools Ribbon Overview**

The Tool Ribbon provides you with clear view of all tools within their categories. Easy access to tools through the ribbon allows you to use GIS Cloud more efficiently. The following is a brief overview of the tools on the ribbon; a more detailed description of the tools will follow.

**Map Tools** - With a focus on the map, this is a clear way for users to reach map-related features.

**Layer Tools** - Provides all functionalities needed to work with layers and datasets.
**Edit Tools** - Tools used for editing layer settings, as well as adding or removing features from layers.

**Select Tools** - Select tools set allow operations to be performed on your layer, geographic area or feature of choice.

**Analysis Tools** - All spatial data included in a project can be analyzed using the following tools.

**Tools** - The tools menu gives access to data-related operations and access to several wizards.
Layers Panel

The Layers panel shows all of the layers of a selected project. The Layer panel also functions as a legend. The following cartographic options are available:

1. **Eye Icon** - Toggles layer visibly on or off.
2. **Slider** for setting the transparency of the currently selected layer.
3. **Adjust layer** appearance on the map. Drag layers to set their display order.
4. **Lock layer** - Layers can’t be edited.
5. **Layer Panel Toolbar** (from left to right):
   - Add Layer
   - Edit Layer
   - Create Folder
   - Delete Layer
   - Rename Layer
   - Zoom to Layer
6. **Toggle Panel** - Double click on the spot the arrow points to hide the Layer panel.
Info and Data Panel

On the Map Editor’s main interface you can access the table overview of the selected feature’s attribute data. This information is available in two ways:

1. **Info Panel** - Use the Identify tool to select a feature. Attribute data is shown in the Info panel.
2. **Data Panel** - You can use this panel to see all the data within a layer. Select the layer and open the Data panel; this gives you an easy access to the data and an understanding of what data in the table are visualized as objects on the map. To do the latter you need to select a row in the table and it will be shown on the map.

Search Tools

Search tools enable you to search for attribute data in the tables. There is one on the right within the Info Panel (2). You can select the layers you want to search from the layer list. There is another search tool on the ribbon as well (1). Select the layer on the map (3) and search through it easily.
Creating A New Map

A map is created in the following way:

1. Select the Map tab.
2. Select New Map.

A map can be created from the Home tab as well by selecting Create New Map in the upper left corner. Map settings are entered in the New Map form. Two types of settings are available - main map Information and Advanced settings.
New Map

Info    Advanced

Name: Registered Cellular Antenna Structure Locations, Florida, 2008

Description: This dataset contains FCC registered cellular antenna structure locations.

Copyright: FCC

Projection: +proj=aea +lat_1=24 +lat_2=31.5 +lat_0=24 +lon_0=-84 +x_0= Clear

Unit: meter

Max zoom: 1:1000

Background color: 

Close    Save
You can set following parameters:

1. **Map name**
2. **Map Description**
3. **Map Copyright** - Allows for text to appear in the lower right corner of the map.
4. **Projection** - Select change, select projection from the list. Alternately the projection can be defined by:
   - Searching for a projection by entering its EPSG number, or
   - Searching for a projection by using keywords
5. **Map units** - Select from Meter, Degree, Foot, Foot_us,...
6. **Max zoom** - Optional setting for scale dependency, limits the scale at which a layer is visible.
7. **Background color** - Define the background of the Map View.

All of this information can also be accessed and edited from the Map Properties tool.
Import and Export Data

- Upload Data
- Drag & Drop
- Web to Cloud Upload
- Adding layers
- Data sources
- Import CSV or XLS
- Layer and map exporting

See also: Tutorial 1: Upload, prepare and add data

Upload Data

You can upload various types of data such as:

1. Spatial Vector files: .shp, .mif, .mid, .tab, .kml, .gpx
2. Spatial Raster files: .tif, .tiff, .jpg, .gif
3. Image files: .jpg, .gif, .swf, .png
4. Excel 2003 and CSV: .csv and .xls

To upload your data to the Map Editor, first you have to open the File Manager by selecting the Upload Data option in the Home tab/Map Gallery or clicking on the File Manager icon in the Tools tab.
In the File Manager select a directory to which you would like to upload your data and select the **Upload** button.

Then, select browse to select files from your computer, click open and wait for the upload to finish.
Drag & Drop

Another way to upload your data, from your file system to the GIS Cloud, is to simply drag your spatial data from your folders to the application running in your browser. With this option you can upload various types of data such as:

1. Spatial Vector files: .shp, .mif, .mid, .tab, .kml, .gpx
2. Spatial Raster files: .tif, .tiff, .jpg, .gif
3. Image files: .jpg, .gif, .swf, .png
4. Excel 2003 and CSV: .csv and .xls

To be able to do that, first you have to log in with your account to the Map Editor application. If you drag and drop your files to the map gallery (Home Tab), then you'll create a new map named after your data you've dropped.
However, if you drag and drop your files to the layers panel of an existing map you're currently viewing, then you'll add additional layers (data) to that map (no new map will be created).

Make sure that you drag and drop all the files that are part of your data (for example, if you want to drop shapefiles then you have to drag and drop all the files that are part of a particular shapefile).

**Web to Cloud Upload**

This feature is ideal for uploading larger data sets as you can now upload those from the Web directly to GIS Cloud. Also in addition to saving time, from now on you can create maps and upload data also from mobile devices like tablets. In the File Manager you can find the Web to Cloud Upload option with which you can directly upload data from web to your GIS Cloud account. With this option you can upload various types of data such as:

1. Spatial Vector files: .shp, .mif, .mid, .tab, .kml, .gpx
2. Spatial Raster files: .tif, .tiff, .jpg, .gif
3. Image files: .jpg, .gif, .swf, .png
4. Excel 2003 and CSV: .csv and .xls

Also, data can be uploaded even if it's in zip format so you don't have to unpack your files.
Simply copy the URL of your data you wish to download, click Start the Transfer button and your data will be automatically uploaded.

**Import CSV or XLS**

If you have data geocoded with location coordinates you can upload it as an Excel table or CSV. This data can then be visualized as a layer. See the sample data table below.
To perform data import go to the Layer Tab and select the Import function.

Browse for the data table on your computer and upload it to GIS Cloud. Set the table parameters and select the coordinate fields. When everything is set browse the output file for which the dataset needs to be created in PostGIS database. The action is set by default for now. Now select Import and your data is ready to use.
Adding Layers

To add layers, first you have to open the Source Browser by selecting Add Layer option that can be found in the Map tab and in the Layer tab or by selecting Add Layer button in the Layers panel.

Layers can be added from several sources: local computer/File System, PostGIS database, Web Map Service, Tile Map Service (Open Street Maps, Google maps etc.), GIS Cloud Maps, Mobile Devices, through Arcmap extension and/or via Mapbox.
Select source and the desired layers you wish to add and press Select to add layers.
In cases where multiple layers will be added, use the Multiple Layer Wizard. If you are adding raster layers then you must check Add as raster layers box. Added layers will now appear in the layers panel and get visualized in the map viewer.

**Data Sources**

This portion of the documentation introduces other types of sources that can be included in a GIS Cloud project. Supported data sources are:

1. **Files** - Upload files from local computer.
2. **PostGIS database** - Load spatial data from the database.
3. **Web Map Server** - Add maps as a standard protocol for serving georeferenced map images over the Internet that are generated by a map server using data from a GIS database.
4. **Tile Map Server** - Loads rasters of maps like Open Street Maps, Google Maps or Bing; these can serve as a simple basemap.
6. **Mobile** - Add data from your mobile device.
7. **Arcmap** - Upload shapefiles with our free extension for Arcmap.
8. **MapBox** - Add basemap layers to your GIS Cloud projects directly from MapBox.

**Source - PostGIS Database**

For the following operations, a PostGIS database is the required data source:

1. Editing geometry.
2. Performing any data editing, calculations, or analysis.

It can be accessed using the Add Layer function in the Map or Layer tabs. It can be managed through the PostGIS database manager in the Tools tab (see Database Manager). A PostGIS database is added to a project as shown below:

1. Select Add Layer from the Layer Tab.
2. Select PostGIS from the dropdown menu.
3. Add PostGIS to your project the same way you add files.

or

1. Select Add Layer from the Map Tab.
2. Select PostGIS in the Source Browser.
3. Add PostGIS to your project same way you add files.
WMS as a Data Source

Web Map Service may be accessed in the same way we accessed a PostGIS database. WMS is added to a project as shown below:

1. Select Add Layer from the Layer Tab.
2. Select WMS from the dropdown menu.
3. Add the WMS URL of the dataset and select Get Info.
4. Select and Add WMS layers to your project.

or

1. Select Add Layer from the Map Tab.
2. Select WMS in the Source Browser.
3. Add the WMS URL of the dataset and select Get Info.
4. Select and Add WMS layers to your project.
TMS as a Data Source

Layers can be added from a Tile Map Service (TMS) with the following steps:

1. Select Add Layer from the Layer Tab.
2. Select TMS from the dropdown menu.
3. Select the Tile Server from which you want to add a Service.

or

1. Select Add Layer from the Map Tab.
2. Select TMS in the Source Browser.
3. Select the Tile Server from which you want to add a Service.
Imported TMS layers appear as topmost layers; drag and drop the TMS layer into the desired viewing position to allow for vector overlay.
GIS Cloud Maps

Add layers from our GIS Cloud Map database with the following steps:

1. Select Add Layer from the Layer Tab.
2. Select GIS Cloud Maps from the dropdown menu.
3. Select map you wish to use.

You can also find Add Layer tool in Map Tab.

We’re constantly adding new maps into our database so feel free to explore them all.

Arcmap as a source

The GIS Cloud Publisher extension for ArcMap is a free tool which lets you move your map from desktop to the Cloud. With a single click you can:

- Create or update a map on your GIS Cloud
- Duplicate your layers structure
• Upload the underlying data - both shape files and geodatabases supported
• Upload your custom symbology
• Publish and share your project easily

MapBox as a source

An easy way of adding basemap layers to your GIS Cloud projects directly from MapBox. Just copy and paste a MapBox Tile URL service into GIS Cloud and the MapBox map will become instantly available in your GIS Cloud project as a layer.

1. Login to mapbox.com.
2. Select or create a map.
3. Open Map details and click on Embed.
4. Paste TileJSON URL in the box above.
5. Click on the Select button below.
Layer and Map Exporting

All layers and maps can be exported into the following file formats: **Vector:**

- Shapefile (.shp)
- MapInfo file (.mif)
- Keyhole Markup Language (.kml)
- Comma-Separated Values (.csv)

**Raster:**

- Portable Network Graphics (.png)
- Geospatial Tagged Image File Format (GeoTiff)

Layer Exporting

Layers are exported as shown below:
1. Select the Layer tab.
2. Select Export.

![Export Wizard](image)

1. Select an export file format.
2. Click the link to download the resulting file.

**Map Exporting**

Exporting a map creates an image of the current Map View as shown below:

1. Select the Map tab.
2. Select Export.
The following parameters must be defined when exporting a map:

1. **Image title** - Choose the map title.
2. **Image dimensions** - Define the size of the exported image, in pixels.
3. **Image format** - Currently PNG is the only supported export image format.
4. **Add Layer Legend to the Image**
5. **Image bounds** - Click the arrow to open the coordinate view. By default the current extent of the Map View is selected. For custom image extents manually enter the coordinates or set the desired map view and select Get Current View.

After setting parameters select **Get Image** button.

**Layer Properties**

Editing the visual settings of added layers:

1. **General settings** - Change the appearance of a layer.
   - Change feature symbology according to various attribute values
2. **Attributes** - Edit layer data columns.
3. **Display** - Define layer bounds and zooming options.
4. **Label** - Define label settings.

Each layer can be edited in the following way:

1. In the Layer panel select the layer you wish to edit.
2. Select Edit.

The selected layer can be edited through the Edit function on the Layer tab as well. See also: Tutorial 3: Classification and appearance settings

**Classification By Attributes**

You can modify the display of a layer based on values of its attributes. Operations can be performed based on distinct or continuous values. To perform these operations the data source must be a PostGIS database (See database manager).
Classification by attributes based on distinct values

1. Select the Distinct radio button.
2. Select the field whose values will define the layer display.
3. Colors will be automatically defined for the features.

You can manually assign colors to each feature by selecting the appearance box. Clear removes all assigned colors. Choose Save after assigning colors.
1. Select the field to define the expression name.
2. Hold the mouse button to drag the expression to a different position.
3. Select Appearance to change the defined color.
4. Add or remove expressions.
### Classification by attributes based on continuous values

1. Select the field whose values will define the layer display.
2. Choose the number of ranges that are to be defined.
3. Assign the minimum value from which the appearance will be defined.
4. Assign the maximum value from which the appearance will be defined.
5. Edit the color manually or edit by selecting Random style.
6. Optionally, you can use the logarithmic scale.
7. Choose Calculate.
8. Boolean expressions and selected colors are displayed as in distinct values.

Clear removes all assigned colors. Choose Save after assigning colors.
Appearance Settings

Edit layer symbology in the layer properties window. To select appearance, click on the colored square. Selecting the box in front of the expression you can write your own label for this value and color.

![Layer properties window](image)

[Image of Layer properties window with expressions and appearance settings]
Editing options for layer symbology:

Visual options

- Change the color of the layer and its border
- Change line and border width

Icon options - here you can manage your symbols by size, color and by its attribute depending on what do you want to depict. There are various symbol data sets that you can use when designing a land use, tourist, sport, health or some other types of maps depending on your needs. Choose your color by using RGB or HSB methods or simply by using a color diagram. Also, there is an option where you can manipulate symbols by making a decision whether you want them to overlap, don't overlap or simply be optimized.
Label options - Change the font and color of labels.
Advanced options - Merge lines with similar attributes for optimized line rendering.

After the changes have been applied select Ok to close the dialog. See also: Tutorial 3: Classification and appearance settings

Display Settings

Here you can set layer bounds. In case there are no bounds, you can select Get bound from source. If you experience difficulties with the layer you can click Clear map tiles and refresh the page. For embedding maps into a web page you can define class and ID of a layer.
Attributes Settings

In Attributes tab you can reorder columns and set which layers attributes you want to view or show in attributes table.
Also, you can use info window to display attributes right on map and set aliases for names of your attribute fields.

Labels

There are two options for labeling features in GIS Cloud: with the first option you can set general label options for the whole layer and with the second option you can define labels for each defined class separately. In the general label options you can set:

Encoding - allows the user to display labels in their native language. Start typing for the dropdown menu.

Tooltip - to enable tooltips on mouse hover, select the field to display by using the Tooltip dropdown.

Hide geometry - with this option you can hide geometry of a feature but labels will still show.
In the label tab of an individual class you can: define what attribute field of a feature will serve as a label; where will be the labeled placed; set margin; define font size and color; define outline color.
Creating and Editing Layers

In addition to uploading data layers, you can also create layers yourself by following the steps listed below:

1. Select the Layer Tab.
2. Select Create.

Choose or enter the data (attributes) that the layer will have:

1. **Table name** - Enter the name of your new GIS data layer.
2. **Geometry type** - Select point, line or polygon as your feature type.
3. **Projection** - Select a new projection or select an existing one being used in the active map.
4. **Overwrite if exists** - You have the option to overwrite an existing data layer if it bears the same name as your new data layer.
5. **Copy Structure Form** - You may define the structure of your data layers table by copying the attribute table from another existing layer. This operation does not define point, line or polygon geometry.
6. **Attributes** - Enter the desired field names for your new data layer and define the field type:
   - String - Input any text
   - Real - Input numbers containing a decimal point
   - Integer - Input whole numbers
Create and Edit Point Layer

Add new point features to the layer by following these steps:

1. Select the newly created dataset on the Layer Panel and select Add feature from ribbon on Edit Tab.
2. Add a point to the map; the layer is now displayed on the map.
3. Enter the attributes in the feature table form.
4. Choose save; the layer can be now modified by using edit tools.

A layer can be edited by following these steps:

1. Select a point layer on the Layer Panel.
2. Select the Edit feature from the ribbon (on the Edit Tab).
3. Select the layer displayed on the map.
4. Move point to the desired location.
5. Choose Save.
Create and Edit Polygon Layer

Polygon layers are created by choosing a created polygon dataset and then clicking Add Feature.

On the layer panel select the created polygon and draw it the following way:
1. Select Add feature from toolbar.
2. Draw the polygon geometry with mouse clicks and line drags.
3. When you’ve vectorized a polygon press enter on your keyboard.

In the end you enter attributes and select Save. The polygon has been created.
GIS Cloud allows you to edit all feature types. Polygons are edited in the following way:

1. Initiate the edit mode by clicking on the Edit feature tool. Click on the feature you want to edit.
2. Vertices will appear; drag vertices as desired.
3. Select Save when finished (or Cancel if you don’t wish to change the geometry).

Pseudo nodes appear between the polygon's vertices to allow greater freedom when changing polygon shapes.

Create and Edit Line Layer

Line layers are created by choosing a created line dataset and then clicking Add Feature. On the layer panel select the created line and draw it in the following way:

1. Select Add feature from toolbar.
2. Draw a line geometry with mouse clicks and line drags.
3. When you’ve vectorized a line press enter on your keyboard.
In the end you enter attributes and select Save. The line has been created.

Lines are edited in the following way:

1. Initiate the edit mode by clicking on the Edit feature tool. Click on the feature you want to edit.
2. Vertices will appear; drag vertices as desired.
3. Select Save when finished (or Cancel if you don’t wish to change the geometry).

Create Mobile Layer

Login to your GIS Cloud account and open a map. The next step is to create a mobile layer in the Layer tab. At this point you need to install the mobile app on your device and associate the device with the new layer.

Visit the Android Market from the link below to install the mobile app. After it’s installed, start the mobile app and get your device ID. Now you can go back to GIS Cloud and choose a name for the layer and enter the device ID. Select Create and you’re ready to start collecting your off-site data.
For more information about the Mobile Data Collection application please see:

- Mobile Data Collection manual.

**Edit Attribute Data**
Whether you have a point or a polygon layer, you can edit its attribute data by following these steps:

1. Select the Identify tool from the Toolbar.
2. Select the layer you want to edit.
3. Double click the attribute field on the Info panel and enter values in the table.
4. Press Enter to save the changes.

**Layers must be added from the PostGIS database to allow attribute editing!**

**Other Edit Features**

The edit tab contains two more functions: Delete Selection and Crop.

**Delete Selection**

If you wish to delete a certain object, or several, you can do it with this function. Select what you wish to delete and click Delete Selection. To delete objects from the layer it is necessary to add the layer from a PostGIS data source.
Crop

If you wish to crop the layer to an object you can do it with this function. Select the layer and then click Crop from Edit tab. Select an area on the map that you want to crop and click on the selection.
Change a layer or add more layers and then select Crop. It is very important to be careful with this function because it changes the source of the layer.

Selecting Layers and Objects

Any feature can be selected. Selected sets allow operations to be performed on your layer, geographic area or feature of choice.

- Select Layer and Identify tool
- Multiselect Methods
- Invert Selection Tool
- Creating a New Layer from Selection
- Spatial Selection

Select Layer and Identify Tool

An entire layer or a subset of features in a layer may be selected in the Map View. Enabling the select tool on the Map View toolbar allows you to create selected sets:

1. The feature table for the selected set can be viewed in the Layer data table at the bottom of the map view. It can be opened in the right corner of the bar.
2. The selected feature is highlighted
Using the Identify tool on the Map View toolbar enables you to see the attribute data of the selected layer. When the tool is used the Info panel appears on the right side. The Info panel can be closed by double clicking on the spot marked with 3 dots (shown by the arrow). You can toggle the Info panel as necessary. You can also search through attribute data with the search tool.

Multiselect Methods

Multiple features may be selected at once. There are two methods for multiselection. The first method is the Select Tool.

1. Click the select tool on the Map View toolbar.
2. Hold the CTRL button to select multiple features in a layer.
The second method is the **Area Selection tool**.

1. Select the layer in the layers panel on which you wish to do a multiselection.
2. Click the Area Select tool on the Map View toolbar.
3. Drag a box to define the area of selected features.
To select an area you must select the layer on which you wish to do a multiselection. The selection of objects can be cleared with the Clear function from the Select Tab.

**Invert Selection Tool**

When layer elements are selected in the Map View, using the Invert Selection tool you can select the unselected layer elements, and unselect the selected ones.

**Before:**

![Before Invert Selection](image1)

**After:**

![After Invert Selection](image2)
Creating a New Layer from Selection

New layers may be created from selected sets:

1. Enable the Area Select tool on the Map View toolbar (or use CTRL + Select Tool)
2. Drag a box to define the area of selected features
3. On the ribbon, choose New layer selection

You have created a new layer. For more about layer editing see the Layer Editing section.
Spatial Selection

Note: spatial selection only works with database layers, not with files. If you want perform spatial queries please import the files into the database first (See database manager or exercise) Spatial selection allows you to create database queries for layers that reside in the database. This tool allows you to select any database feature from any database layer in your Map View. You can select by attributes or by location depending on what do you need.

1. Click the Select tab
2. Select Spatial Selection

Basic spatial selection is performed in the following way (use the pictures above and below for reference):

From the first dropdown (layers), select a layer. Now from the second one (columns) select the attribute you wish to query. You can query with multiple layers/attributes by adding them with button.
In the Condition field enter the conditions for spatial selection. You can choose from the operators offered at the bottom, or type them in yourself (the Help link leads to the list of PostGIS operators).

To perform the selection click Select.
GIS Analysis

All spatial data included in a project can be analyzed using the following tools:

1. Area analysis
2. Buffer analysis
3. Two Layer Comparison analysis
4. Hotspot analysis
5. Radius Coverage analysis

To access analysis tools go to the Analysis tab. You can perform Analysis only with layers added from a PostGIS data source.

Area Analysis

Area analysis calculates the surface area of a selected object. To perform Area analysis, first use the Select tool to select the objects.
After selecting the features you're interested in, you need to define the units of measure. Select Calculate for Selection to see the result.

**Buffer Analysis**

Buffer analysis creates a zone around a point, line or polygon. You can identify whether there are objects of interest inside the zone or outside the zone and make conclusions based on this analysis. After selecting Buffer analysis from the menu you need to set following options:

1. Analysis name
2. The layer to perform the analysis on
3. Define the buffer distance and the unit of measure
4. Choose whether you want to group (merge) the buffers
5. Define the symbology of the buffer polygon
See images below for a grouped geometry buffer on a point layer.
Two Layer Comparison

Two layer Comparison outputs an area calculation for the intersecting portions of two polygons:
1. Select the layers to compare
2. Select the attributes to be compared (2)
3. Click Analysis
4. The analysis returns the area values of the two intersected areas.

Results can be exported as an .CSV file.

---

**Polygon Layer Intersection Analysis**

First Layer: Townships
Attribute: area
Second Layer: Carbon Monoxide Non-Attainment Areas

**Result:** Total percentage of intersection is 5.17% which is 1.41 of 27.2926538544 of 'area' total sum.

Download CSV table

---

**Hotspot analysis**

Hotspot analysis visualizes the density of points in a layer.

**HotSpot Analysis**

Layer: poi
Distance: 300 meters

To perform the analysis you need to set following options:
1. The layer you wish to perform analysis with (point layers only)
2. The minimum distance between points taken into consideration to calculate density

Select Show hotspots to see the results.

**Radius Coverage**

Radius coverage allows you to select features within a specified distance from a defined point.
Radius coverage is performed in following way:

1. Select the Add feature tool from the form
2. Establish the center point of your analysis
3. Define the radius
4. Select Create Radius Layer
Tools Tab

The tools tab gives access to the following operations in the ribbon:

1. Work with files
2. Work with the database
3. Set spatial projection options
4. Merge two shapefiles into one
5. Geocode your data

File Manager

This tool is used to upload as well as arrange your files. More about working with the File Manager can be found in the Import and Export Data section.
The file manager offers the following functionalities:

1. **Address bar**
2. **File overview**
3. **Tools**
   - Refresh current folder.
   - Select all folder elements.
   - Create new folder.
   - Duplicate selected elements.
   - Copy files or folders.
   - Move files or folders.
   - Rename files or folders.
   - Delete files or folders.
4. **Upload files from local computer**
5. **Search files**

See also: Tutorial 1: Upload, prepare and add data

**Database Manager**

To perform editing or data analysis, the layers you're working with must reside in the PostGIS database. The Database Manager allows you to import layers into the database.
1. **PostGIS connection** - Enables PostGIS connections. For cases where the connection is not established choose Connect.

2. **Database overview** - A detailed list of all the current databases.

3. **Import** - Tool for adding layers into a database.

4. **Tools**
   - Enable refreshing tables.
   - Select all database elements.
   - Unselect all database elements.
   - Rename table.
   - Export PostGIS layer as ESRI Shapefile, MapInfo file, KML and CSV file. See more in the Layer Exporting section.
   - Duplicate database elements.
   - Truncate selected tables.
   - Delete selected tables.

5. **Filter** - Enables database search.

To import your data to PostGIS database you don’t need to create a new database unless you have your own PostGIS database you wish to connect to the GIS Cloud. In that case you can create a connection to your database by clicking on New option. When creating or editing a connection you must set the connection options. GIS Cloud can connect to a local or a remote database:
1. **Connection name**
2. **Server** - You need to enter the address of the database you want to establish a connection with (for local database set this to "localhost" or your IP address).
3. **Port** - The default server port for PostGIS databases is 5432 but you can enter your own if you're using a nonstandard port
4. **Database name**
5. **Username**
6. **Password**
7. **SSL (Secure Socket Layer)** - Set the desired level of connection security from the dropdown menu.
8. **Scheme** - By enabling this you choose to see only public schema tables.

Whether you've connected to a new database or you left the default database "GIS Cloud local" you can simply import data by clicking on import button (more information in the tutorial - link below).

See also: Tutorial 1: Upload, prepare and add data

**Projection Wizard**

The Projection Wizard tool enables you to add a projection or change an existing projection.

1. **Browse** to a source data layer, If the layer's projection has been detected, it will appear in the form.
2. If the projection has not been detected, you can specify it here.
3. **Select** projection (SRS - Spatial Reference System Identifiers) and click Select to add it.
4. Choose Assign an output SRS to correct the current projection (4). If you wish to transform the layer from an existing projection to the newly selected one, choose Reproject/Transform to SRS on output.

To help you find the projection you want, you have a search tool at your disposal. For more information on projections, visit http://www.spatialreference.org.

### Merge Wizard

The Merge Wizard enables you to merge several files into one. The only file formats currently supported for this operation are ESRI Shapefiles and GeoTiff files. More file types will be added in the future. Browse to select the files you wish to merge. Once you have added the desired files you will see them appear in the list. Before merging, you need to select a name for the new file; this is the file into which the selected files are going to be merged. Select the location of the new file by clicking Browse and using the File Manager.
Geocoder

With the Geocoder you can easily convert non-spatial location data into its matching spatial representation. Geocoding allows users to translate an address into coordinates and vice versa.

For geocoding you will need an excel or a csv table containing data you want to geocode and the address model data that will be the basis for geocoding.
In the Search tab you can search through your address model data and position yourself to any searched address by clicking on Show on the active map button.

In the Results tab you can see an overview of a geocoding process. Here you can find which addresses were geocoded right and which weren’t. If you click on the Get error report button you will get a detailed report of all the addresses that weren’t geocoded properly.
### Geocoding Wizard

**Parameters** | **Search** | **Results**
---|---|---

Total: 12, Valid: 6, Errors: 6

<table>
<thead>
<tr>
<th>GC_Status</th>
<th>Datum</th>
<th>Vrijeme</th>
<th>Dan</th>
<th>Vatrogsna_post</th>
<th>Vrsta_intervenc</th>
<th>DVD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td>Ok</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td>Ok</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td>Ok</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td>Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td>Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td>Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td>Error</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td>Ok</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
<tr>
<td>Ok</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>DVD</td>
</tr>
</tbody>
</table>

Show location on click

- Close
- Start geocoding
- Import results
Sharing and Publishing

GIS Cloud has several options for sharing and publishing data. To share or publish data, first select the Map tab and then click Share or Publish from the ribbon. These related sections follow:

- Map Sharing with other GIS Cloud users
- Setting Layer Permissions
- Embedding Maps into a Web Page
- Web Map Service (WMS)

Map Sharing

Collaborate from the Share panel:

1. **Public**- These maps are visible to everyone, whether they’re registered or non-registered:
   - Click Publish to Public
The maps is now visible on the Home tab and is available to all GIS Cloud users, even prior to logging into the GIS Cloud interface.

2. **Share with other GIS Cloud users** - Collaborate with other GIS Cloud users
   - Provide the user name of another GIS Cloud user and the map you have published will appear in that user's project panel.

3. **Permissions**
   - Selecting **edit** in the box labeled Owner will allow the person you have shared your map with complete editing privileges.
   - Selecting **view** in the box labeled Owner will allow the person you have shared your map with only viewing privileges.

4. **Permalink** - The URL appearing in the permalink field allows you to share a direct link to your project from any browser. The opens identical to yours with your current settings enabled. The target user must be logged into GIS Cloud to access the link.

---

**Set Layer Permissions**

All layers are exportable by default. When you share your map with another GIS Cloud user you might not want to allow that user to export your data as a Shapefile and to be able to download it. You have to change that layer's permission setting to Not exportable. All you need to do is click on the link.
Embedding Maps into a Web Page

Choosing the embed tab on the Share and Publish panel allows you to easily extract code for the embedding of your map in a 3rd party website. The following settings are available:

1. Define your preferred scripting platform:
   - GIS Cloud (Javascript)
   - Google Maps (Javascript)
2. Width X Height - Define the dimensions of the object
3. Choose your content display method
4. Options - Opt to include a toolbar, a Layer List (Legend) and/or Info Popups
5. Popup Preview – Examine a complete preview of your map prior to embedding
6. Code - Copy code into the part of the page where you want to show the map
There are some differences in the forms for each of the scripting platforms but in general the settings are the same. If you experience any problems or issues with the maps, use Clear Tile Maps and then try again.

**Web Map Service - WMS**

In order to share your GIS Cloud map on a third party web sites as a Web Map Service (WMS), this setting must be enabled. Use the WMS URL to share your data as WMS.
Tutorials

For the following tutorials please download these shapefiles from http://www.diva-gis.org/gdata:

- United States Administrative areas (USA_adm1 and USA_adm2)
- United States Roads

Tutorial 1: Upload, prepare and add data
Tutorial 2: Geocode your data
Tutorial 3: Classification and appearance settings

Uploading data from your computer

Before creating a new map you have to upload data from your computer to GIS Cloud with our File manager. There are several ways you can access the File manager:

1. Upload Data option in the Home Tab
2. File manager option in the Tool tab
3. Add layer option

To upload data from your computer do the following steps:

1. Click **Upload** button.
2. You can choose whether you want to use basic or enhanced uploader depending on file size and on how many files you want to upload. In this example we will use enhanced uploader for multiple files.
3. Click Browse and select all files named USA_adm1, USA_adm2 and USA_roads.
4. After the upload is complete click close.
Next thing we want to do is to arrange our files in separate folders and organize them the way we want:

1. Click New Folder button. At the bottom of the File manager window type GIS_Cloud_tutorial and click create.
2. After you've created a new folder select all the uploaded files and click Move to button. Select GIS_Cloud_tutorial folder and click Ok.
3. Double click on GIS_Cloud_tutorial folder.
4. Select USA_adm1 files, click Rename button, type USA_state and press enter.
   Rename USA_adm2 into USA_county. Note: you have to rename all files for shapefiles to work.

Transfering data into PostGIS database

To perform editing or data analysis, the layers you're working with must reside in the PostGIS database. The Database Manager allows you to import layers into the database. You can connect to an existing database or create a new one.

1. Open Database Manager in the Tool tab.
2. For this tutorial we will use an existing PostGIS database but you can create a new one. Click New button (values in the table below serve as an example and are not the values you need to type to create your own database).

3. New window will appear:
   - In the Name tab type the name of your new PostGIS connection.
   - In the Host tab you need to enter the address of the database you want to establish a connection with (for local database set this to “localhost” or your IP address).
   - Port – The default server port for PostGIS databases is 5432 but you can enter your own if you’re using a nonstandard port.
   - Type the name of your database.
   - Set username and password for your database.
   - SSL (Secure Socket Layer) – Set the desired level of connection security from the dropdown menu.
   - Scheme – By enabling this you choose to see only public schema tables.
   - Click Test connection and then Save if you want to create your own database with your postgis information. Otherwise click Cancel.

4. Next step is to import data that you've uploaded with File Manager into PostGIS database. Click Import button.

5. Select all files from GIS_Cloud_tutorial and click Select.
6. Here you can change the name of your table or projection you need, set encoding and geometry type. Encoding option allows the user to name the table in their native language. In this example leave everything as it is. Note: sometimes auto detect can't recognize some of the uploaded files so you will have to manually set geometry type of a feature.

7. Click Import.

Adding layers

Layers can be added from several sources: local computer, PostGIS database, Web Map Service, Tile Map Service such as Open Street Maps, GIS Cloud Maps, mobile devices, through Arcmap extension and/or via Mapbox.

If you want to add layers from your computer select File System and then choose what data you want to add. Make sure you set All Spatial Files in the type tab.

1. Select Add Layer from the Map tab or from the dropdown menu on the Layer tab.
2. Select PostGIS source and add USA_state, USA_county and USA_roads shapefiles.
3. Select Add Layer again and now choose Tile Map Service source and select Google Maps Terrain.
4. In addition you can add layers through Web Map Service source by typing a WMS URL and selecting map you want to add.

Import Layer from CSV file

If you have data geocoded with location coordinates you can upload it as an Excel table or CSV. This data can then be visualized as a layer.

1. Go to the Layer Tab and select the Import function.
2. Click Browse and select csv or xls file you want to import (File manager opens with files you've uploaded).
3. Define what fields represent Longitude and Latitude.
4. You can create new output or select an existing layer as an output but in that case you will overwrite an existing layer.
5. Click Import.

### Tutorial 2: Geocode your data

In this tutorial you will learn how to geocode your data with GIS Cloud Geocoder. For this exercise you will need an excel or a csv table containing data you want to geocode and the address model data that will be the basis for geocoding. You can access Geocoding wizard by clicking the Geocoder button in the Tools tab:

1. Select the Parameters tab and browse for excel or csv file that contains the data you wish to geocode.
2. Define the column separator and the first header row.
3. In the Address model column browse for data that will be the basis for geocoding. Make sure that the address model data is previously transferred into PostGIS database (see Tutorial 1).

4. In the Address fields you have to define Source and Address model options depending on how did you organize data you want to geocode and data that will be the basis for geocoding.

   - In the Source options you have to define which fields in your excel/csv file represent the address, the number and the municipality. In the picture below you can see the excel table that contains the data we want to geocode. Addresses of our data in the excel table reside in the Location / Address field so we will use that field as an Address in the Source options. In addition you can define number and municipality depending on how did you organize your data in the excel table. For example you can use first field in your excel table just for textual part of your address, second field only for number of your address and third field for municipality if you have more streets that have the same name but are located in different municipalities.
5. In the Address model options you have to define which fields in your address model data represent the address, the number and the municipality. Also, you can define Alternate name field in case you have some kind of truncated or altered name addresses that you want to use for geocoding as well. Like in Source options, define all the fields depending on how did you organize your address model data.

6. In the Output option define the name of a new layer that will be created. This layer will contain results of a geocoding process.

7. When you have set all the parameters click button. Click on the Results tab where you can see an overview of a geocoding process. Here you can find which addresses were geocoded right and which weren't. If you click on the Get error report button you will get a detailed report of all the addresses that weren't geocoded properly.
8. If you are satisfied with the results simply click the Import results button and a new layer will be created in the PostGIS database.

9. Also, in the Search tab you can search through your address model data and position yourself to any searched address by clicking on Show on the active map button.
Tutorial 3: Classification and appearance settings

For the following tutorials please download these shapefiles from http://www.diva-gis.org/gdata: United States Administrative areas (USA_adm1 and USA_adm2) United States Roads In this exercise you will learn how to:

1. Classify attributes based on their distinct or continuous values.
2. Manage feature's appearance settings.
3. Manage labels.

Classification by attributes

You can modify the display of a layer based on values of its attributes. Operations can be performed based on distinct or continuous values. To perform these operations the data source must be a PostGIS database (See database manager).

Classification by attributes based on distinct values

First you will classify by attributes based on their distinct values (attributes that have the same values will be classified into the same category):
1. Select layer USA_county and click Edit in the Layer tab or simply double click the layer in the layers panel to access Layers properties.
2. Select tab General.
3. Click on the wizard button.
5. In the Column drop down menu select Name_1 attribute on which the classification will be based on and click Calculate.
6. You can see calculated expressions that represent the basis for attribute classification. You can add, remove or change expressions (more info following in the tutorial).
7. Press Toggle label/expression button and type the name of the class. For example in the first class type „Alabama“, in the second class type „Indiana“ and so on. You can choose whether you want to show expression or label for each of the classes separately or you can toggle expression for all of them.
8. Click Save.

**Classification by attributes based on continuous values**

Classify by attributes based on continuous values (attributes are classified into defined range classes that represent a set of values):

1. Select the layer USA_state and click Edit in the Layer tab or simply double click the layer in the layers panel to access Layers properties.
2. Select the tab General.
3. Click on the wizard button.
4. Choose Continuous values.
5. In the Column drop down menu select shape_area attribute on which the classification will be based on.
6. Number of ranges (classes) set to 5.
7. Minimum and maximum value will be calculated by default but you can set your own values. For this example leave it as it is and click Calculate.
8. Once again you can see calculated expressions:
   - Click on the expression of the first class and change number 56.2621716 into 5.000000. Change all numbers in all expressions like it is shown in picture below.
With expressions you can manually manipulate attributes values so you could better visualize your data.

**Appearance settings**

1. Select layer USA_roads and double click it to get to the Layers properties.
2. Click on the Appearance box next to the expression.
3. In the Visual tab select color box. Here you can define color by using RGB and HSB method or simply by clicking on the color of your choice. For this tutorial define color with RGB method: set R to 235, G to 10, B to 50 and click button.
4. Set Line width to 2.
5. Border color and width is used for polygon shapes so in this example leave these options set by default.

6. In the Icon tab you can manipulate appearance of point features.
   1. You have the option to choose from various sets of predefined symbols.
   2. You can create your own custom symbol or upload an existing one.
   3. Set size and color of your selected or created symbol.
   4. With the option Allow Overlap you can define whether you want for your symbols to overlap, be optimized or you want them not to overlap. With this option you can significantly affect visualization of your features depending on what do you want to depict.

5. Click Ok and Save.

---

You can set appearance for every expression you create which enables you to manipulate classified attributes by size and color. For example, if you classify roads by type into major roads and highways you can manually set appearance for each class to achieve better and more accurate visualization of your data.

**Manage labels**

There are two options for labeling features in GIS Cloud: with the first option you can set general label options for the whole layer and with the second option you can define labels for each defined class separately. First lets set general label options:

1. Double click the USA_state layer and in the Layer properties select the Label tab.
2. Set Encoding to US-ASCII (character set for United states). With the encoding you have the ability to type labels in your native language.
3. In the tooltip dropdown menu select attribute name_1.
4. Hide geometry box leave unchecked. With this option you can hide features but their labels will still show.
To define labels for each class do the following:

1. In the Layers properties of the USA_state layer select the General tab.
2. Click on the appearance box next to the „small states“ expression and select the Label tab.
3. In the Label drop down menu set the attribute name_1 that will show as a label.
4. The Text option is for line features where you can place text along the line. Leave it empty for now.
5. In the Placement drop down menu set Top as the position of your label. Also, you can type coordinates for your labels if you are working with layers that are rendered as a raster.
6. Set margin to 5 and font size to 15.
7. Leave color as it is and click Ok.
8. Click on the appearance box next to the „large states“ expression and select the Label tab.
9. Set font size to 25 and define everything else like it is in „small states“ class.
10. Click Ok and Save.
Set Scaling Options

With scaling options you can manipulate appearance of your features by setting scale boundaries. In this tutorial we will set scaling options for USA_roads layer:

1. In the Layers properties of the USA_roads layer select the General tab.
2. Click on the appearance box next to the expression and select the Advanced tab.
3. Set boundaries from 6 to 10 like it is shown in the picture below. You can set the range of your boundaries from 1 (no zoom) to 22 (maximum zoom). The number in the grey box shows you the level (zoom) of your current map view.
4. Take note that if you click once on the zoom tool (+/- zoom options) then you will zoom for 1 level.
5. Click save and close.
6. Try to zoom in and zoom out.
Map Viewer Manual

This manual will allow users to easily navigate through the Map Viewer user interface. The manual illustrates the functionality, options and methods required to leverage the power of this application. For those new to GIS, this manual will also serve as an excellent primer for GIS.

- Introducing Map Viewer
- My Account
- Main User Interface
- Selecting Layers and Objects
- Layer and Map Exporting

Introducing Map Viewer

What is Map Viewer?

An easy way to view and access maps and data. Optimized for non-professionals that need a simple and easy way to access maps and geospatial content.
Why Map Viewer?

Map viewing

- Secure private access
- View and access shared or public maps

Information retrieval

- Table view
- Pop-up view
- Identify tool

My Account

Before you get started you have to create a new account through our sign up form. In addition to our regular sign in form, you have the option to sign in instantly with the social network you use.
The My Account dialog allows you to edit your personal information and login information.

**Personal Information**

- **First name**: test
- **Last name**: 
- **Company**: GIS Cloud
- **Web**: 
- **Email**: info@giscloud.com
- **Phone**: +447758035881
- **Language**: English

**Login Information**

- **User name**: test
- **Password**: 
- **Password**: 
  - **Active**: 

**Subscription**

[Close] [Save]
Main User Interface

When you begin to use the Map Viewer you must first get acquainted with the user interface. It is a part of platform which offers complete oversight of projects.

In this manual, we have placed a red number over each pictured interface; that number corresponds to the instructions for each product feature.

1. **Log in and My Account** – You need to log in using your User Name and Password to access Map Viewer. After that you will be able to use the application fully. After logging in, you will be able to modify your user account.

2. **Tool Ribbon** – Here we offer complete access to the application’s features. The tabs above the ribbon reveal additional tools.

3. **Toolbar** – Provides the tools needed for basic operations with maps. Toolbar functions are described in the separate chapter Toolbar.

4. **Project Name bar** - Displays the project name as a link. You can send someone a link to the map by using the address that the link points to, or you can refresh the map by clicking on the link.

5. **Layer panel** – A “table of contents” type of display for the active project. The layer panel offers the following functionality:
   - Drag and drop ordering – Control layer display order
   - Lock layers – Prevent editing and deletion
   - Layer visibility – Toggles the display of the selected layer.
7. **Map Viewer** – Map display of visible layers and cartographic features.
8. **Layer Data Table** – Table displaying all attribute records and fields of a selected dataset.
9. **Info Table and Search tool** – View info about selected feature and search for specific features.

For better viewing experience we’ve implemented an option to hide tool ribbon and layer panel. The red dots (on picture below) mark positions of the sliders where you can toggle the ribbon, the layer panel and the info panel (hidden by default) on and off.

---

**Home Tab**

The Home tab is a centralized place to access all maps you have access to – maps someone has shared with you or public maps. The menu on the left provides not only easy access to all of
your maps, but easy discovery of and access to new maps and data. You can browse available maps by directories, search for maps or just go for the recently open maps. The gallery provides easy access to all of the maps available to your user account, whether the maps are created by you, shared with you or publicly visible.

**Toolbar**

The tools and their functions are:

1. **Pan** – Enables the user to interactively move the Map View position.
2. **Zoom** – Left click and drag a rectangular box on the map to define the desired view extend. Zooming can also be achieved by a mouse scroll or by using the slider to the left.
3. **Zoom to Full Map Extent**
4. **Select** – Selects a single feature in an active layer.
5. **Identify** – Identifies an element on the map and shows its attribute information.
6. **Area Selection** – Clicking and dragging a rectangular box with the mouse creates a selected set of features from an active layer.
7. **Measuring Tool** – Interactive display of distances on the Map View. Left clicking will allow distance display over multiple vertices.
8. **Print** – Any created map can be printed.
9. **Scale**  
10. **Jump to Coordinates** – Zoom to a set of coordinates – The current coordinates of the mouse cursor are displayed. To define specific coordinates and have the view zoom to the specified position, left click; enter coordinate information.

11. **Number of Selected Objects on the Map**

**Layers Panel**

The Layers panel shows all of the layers of a selected project. The Layer panel also functions as a legend. The following cartographic options are available:

1. **Eye Icon** – Toggles layer visibly on or off.
2. **Slider** for setting the transparency of the currently selected layer.
3. **Adjust layer** appearance on the map. Drag layers to set their display order.
4. **Lock layer** – Layers can’t be edited.

5. **Layer Panel Toolbar** (from left to right):
   - Add Layer
   - Edit Layer
   - Create Folder
   - Delete Layer
   - Rename Layer
   - Zoom to Layer

6. **Toggle Panel** – Double click on the spot the arrow points to hide the Layer panel.

**Info and Data Panel**

On the Map Viewer’s main interface you can access the table overview of the selected feature’s attribute data. This information is available in two ways:

1. **Info Panel** – Use the Identify tool to select a feature. Attribute data is shown in the Info panel.

2. **Data Panel** – You can use this panel to see all the data within a layer. Select the layer and open the Data panel; this gives you an easy access to the data and an understanding of what data in the table are visualized as objects on the map. To do the latter you need to select a row in the table and it will be shown on the map.
Search Tools

Search tools enable you to search for attribute data in the tables. There is one on the right within the Info Panel (1). You can select the layers you want to search from the layer list. There is another search tool on the ribbon as well (2). Select the layer on the map and search through it easily.
Selecting Layers and Objects

Any feature can be selected. Selected sets allow operations to be performed on your layer, geographic area or feature of choice.

- Select Layer and Identify tool
- Multiselect Methods
- Spatial Selection

Select Layer and Identify Tool

An entire layer or a subset of features in a layer may be selected in the Map View. Enabling the select tool on the Map View toolbar allows you to create selected sets:

1. The feature table for the selected set can be viewed in the Layer data table at the bottom of the map view. It can be opened in the right corner of the bar.
2. The selected feature is highlighted.

Using the Identify tool on the Map View toolbar enables you to see the attribute data of the selected layer. When the tool is used the Info panel appears on the right side.
Multiselect Methods

Multiple features may be selected at once. There are two methods for multiselection. The first method is the Select Tool.

1. Click the select tool on the Map View toolbar.
2. Hold the CTRL button to select multiple features in a layer.

The second method is the Area Selection tool.

1. Select the layer in the layers panel on which you wish to do a multiselection.
2. Click the Area Select tool on the Map View toolbar.
3. Drag a box to define the area of selected features.
Spatial Selection

Note: spatial selection only works with database layers, not with files. If you want perform spatial queries please import the files into the database first. Spatial selection allows you to create database queries for layers that reside in the database. This tool allows you to select any database feature from any database layer in your Map View. You can select by attributes or by location depending on what do you need.

1. Click the Select tab
2. Select Spatial Selection
Basic spatial selection is performed in the following way (use the pictures above and below for reference):

From the first dropdown (layers), select a layer. Now from the second one (columns) select the attribute you wish to query. You can query with multiple layers/attributes by adding them with the button.

From the first dropdown (layers), select a layer. Now from the second one (columns) select the attribute you wish to query. You can query with multiple layers/attributes by adding them with the button.
In the Condition field enter the conditions for spatial selection. You can choose from the operators offered at the bottom, or type them in yourself (the Help link leads to the list of PostGIS operators). To perform the selection click Select.
Layer and Map Exporting

All layers and maps can be exported into the following file formats:

**Vector:**
- Shapefile (.shp)
- MapInfo file (.mif)
- Keyhole Markup Language (.kml)
- Comma-Separated Values (.csv)

**Raster:**
- Portable Network Graphics (.png)
- Geospatial Tagged Image File Format (GeoTiff)

Layer Exporting

Layers are exported as shown below:

1. Select the Layer tab.
2. Select Export.

![Export Wizard]

1. Select an export file format.
2. Click the link to download the resulting file.
Map Exporting

Exporting a map creates an image of the current Map View as shown below:

1. Select the Map tab.
2. Select Export.

The following parameters must be defined when exporting a map:

1. **Image title** – Choose the map title.
2. **Image dimensions** – Define the size of the exported image, in pixels.
3. **Image format** – Currently PNG is the only supported export image format.
4. **Add Layer Legend to the Image**
5. **Image bounds** – Click the arrow to open the coordinate view. By default the current extent of the Map View is selected. For custom image extents manually enter the coordinates or set the desired map view and select Get Current View.

After setting parameters select the **Get Image** button.
Asset Data Collection and Management Manual

This user manual contains all information about the Asset Data Collection and Management system features. Described functionality followed with images from the application introduces users in a simple way to all features.

- Introducing Asset Data Collection and Management
- My Account
- Main User Interface
- How Does It Work

Introducing Asset Data Collection and Management

What is Asset Data Collection and Management?

Asset Data Collection and Management is a simple and easy to use system for managing your on field collected data in real time. Before this application users encountered problems such as: bad quality incomplete, often unavailable and outdated data; non standardized collecting methods; discontinuous workflow that resulted in high cost management.
• Collect data in real time
• Available low cost data
• Manage data off site
• Simple application (branding for your needs)
• Tasks assigned in real time
• High security
• Data privacy

What can i do with the Asset Data Collection and Management?

Manage and Collect Data in Real-time

• Collect information from field using the Mobile Data Collection
• Delegate a work order to one of the organizations
• Custom form with work order details (location, category, dispatcher, forwarding history)
• Multiple user roles (administrator, manager, dispatcher, field worker)

Detailed Reporting & Work Orders

• Daily, monthly and annual activity reports
• Table view
• Export to Excel
• Generate work orders into a PDF

Record Forwarding

• Forward record with an email that contains textual and multimedia content
• Each forwarded record is being logged
• Know exactly who is responsible person for each record
• Alternative forwarding through telephone, telefax, text message, ...

Connect Multiple Mobile Devices

• Compatible with multiple mobile devices on field
• Each device is linked to an individual which is also recorded
• Multimedia player for image & audio content
• Automatically reproduces content from mobile devices
My Account

Before you get started you have to create a new account through our sign up form or sign up instantly with the social network you use.

My Account dialog allows you to edit your personal information and login information.
### My Account

#### Personal information

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>test</td>
</tr>
<tr>
<td>Last name</td>
<td></td>
</tr>
<tr>
<td>Company</td>
<td>GIS Cloud</td>
</tr>
<tr>
<td>Web</td>
<td>web</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:info@giscloud.com">info@giscloud.com</a></td>
</tr>
<tr>
<td>Phone</td>
<td>+447760036661</td>
</tr>
<tr>
<td>Mobile</td>
<td></td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
</tr>
</tbody>
</table>

**Save** button

---

### My Account

#### Login information

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>test</td>
</tr>
<tr>
<td>Password</td>
<td></td>
</tr>
<tr>
<td>Password confirmed</td>
<td>✓ Active</td>
</tr>
</tbody>
</table>

**Save** button
Main User Interface

In this manual, we have placed a red number over each pictured interface; that number corresponds to the instructions for each product feature.

1. **Log in and My Account** - You need to log in using your User Name and Password to access Asset Data Collection and Management app. After that you will be able to use the application fully. After logging in, you will be able to modify your user account.

2. **Tool Ribbon** - Here we offer complete access to the application’s features. The tabs above the ribbon reveal additional tools. Tool Ribbon functions are described in the separate chapter Tool Ribbon.

3. **Toolbar** - Provides the tools needed for basic operations with maps. Toolbar functions are described in the separate chapter Toolbar.

4. **Info panel** - Displays information of a selected feature.

5. **Layer pane** - A “table of contents” type of display for the active project. The layer panel offers the following functionality:
   - Drag and drop ordering – Control layer display order.
   - Lock layers – Prevent editing and deletion.
   - Layer visibility – Toggles the display of the selected layer.
   - Transparency (bottom) – Transparency of the selected layer increases as slider is moved to the left.
   - Toolbar – Buttons include the following functions for the selected layer:
     - Add
     - Edit
6. **Data Table** - display of all collected data in real time.
7. **Map Viewer** - Map display of visible layers and cartographic features.

For better viewing experience we’ve implemented an option to hide tool ribbon and layer panel. The red arrows (on picture below) mark positions of the sliders where you can toggle the ribbon, the layer panel and the info panel on and off.

**Toolbar**

The tools and their functions are:

1. **Pan** – Enables the user to interactively move the Map View position.
2. **Zoom** – Left click and drag a rectangular box on the map to define the desired view extend. Zooming can also be achieved by a mouse scroll or by using the slider to the left.
3. **Zoom to Full Map Extent**
4. **Select** – Selects a single feature in an active layer.
5. **Identify** – Identifies an element on the map and shows its attribute information.

6. **Area Selection** – Clicking and dragging a rectangular box with the mouse creates a selected set of features from an active layer.

7. **Measuring Tool** – Interactive display of distances on the Map View. Left clicking will allow distance display over multiple vertices.

8. **Print** – Any created map can be printed.

9. **Scale**

10. **Jump to Coordinates** – Zoom to a set of coordinates – The current coordinates of the mouse cursor are displayed. To define specific coordinates and have the view zoom to the specified position, left click; enter coordinate information.

11. 1 selected objects **Number of Selected Objects on the Map**

**Tools Ribbon Overview**

Tools Ribbon provides you with clear view of all tools within their categories. Some of the basic tools you can use to manage your work orders are; tools for creating reports in pdf or excel form; tool for administering and filling your default tables, forms and databases; tools for connecting multiple devices; analysis and selecting tools; tools for visualization etc. In addition, you can use a custom made tools for managing your data depending on your needs.

With administrator privileges you can even edit location or delete submissions to filter or correct any kind of corrupted data.

**Layers Panel**

The Layers panel shows all of the layers of a selected project. The Layer panel also functions as a legend. The following cartographic options are available:
1. **Eye Icon** – Toggles layer visibly on or off.
2. **Slider** for setting the transparency of the currently selected layer.
3. **Adjust layer** appearance on the map. Drag layers to set their display order.
4. **Lock layer** – Layers can't be edited.
5. **Layer Panel Toolbar** (from left to right):
   - Add Layer
   - Edit Layer
   - Create Folder
   - Delete Layer
   - Rename Layer
   - Zoom to Layer

**Info Panel**

In the Info Panel you can view attributes and find additional info about a selected submission/feature.
Also, you can analyse photos and listen to audios that are attached to a feature you’re viewing.

**Data Table**

Here you can view, search through and process all submitted data that has been collected on field. Data table is filled automatically with all the data sent from the mobile data collection application or from the application of your choice. Every submission gets its own ID that is automatically assigned when you receive a submission.
How Does It Work?

- Add and Associate Mobile Devices
- Collect Data
- Process Data
- Create Detailed Reports
- Create Work Orders

Add and Associate Mobile Devices

First you have to add your mobile devices to the Asset Data Collection and Management so you could instantly send data from your mobile phone to the application.
For collecting data on site you need the Mobile Data Collection app installed on your mobile phone. Once you've added Device ID you can immediately start sending data to your application. To associate device ID's to a person simply click on the mobile devices button and type the name of the device ID owner.

Collect Data

The first step is to collect a good quality and valid data. You can use our Mobile Data Collection Application to locate and collect data including photos, audio records and text comments about a observed feature. Also, you can use other applications of your choice to collect data and connect to the Asset Data Collection and Management Application. All collected data about recorded road damages are sent to the application in real time so you can start processing data almost immediately.
Process Data

When creating a work order you have to make a decision about who will be responsible for assigned work and what type or work is needed. In order to make these decisions quickly and accurately you need a simple solution for reviewing all relevant data. In the data table you can view all submitted data that has been collected in the field.

**Every sent submission automatically gets its own ID in the Work Order Management application.**

<table>
<thead>
<tr>
<th>ID</th>
<th>Submitted by</th>
<th>Submission time</th>
<th>No Da Solved on the field</th>
<th>Category</th>
<th>Accuracy</th>
<th>Media</th>
</tr>
</thead>
<tbody>
<tr>
<td>10516</td>
<td>NC 2 - Z.Lametić</td>
<td>10/07/2012 13:45:54</td>
<td>2 0</td>
<td>Zimske službe/Ostalo</td>
<td>5</td>
<td>Obreni</td>
</tr>
<tr>
<td>10515</td>
<td>NC 2 - Z.Lametić</td>
<td>10/07/2012 13:38:05</td>
<td>2 0</td>
<td>Zimske službe/Ostalo</td>
<td>10</td>
<td>Obreni</td>
</tr>
<tr>
<td>10514</td>
<td>NC 4 - N.Tepić</td>
<td>10/07/2012 13:33:07</td>
<td>3 1</td>
<td>Signifikantne/Vertikalne</td>
<td>10</td>
<td>Obreni</td>
</tr>
</tbody>
</table>

View photos and listen to audio recordings.
Locate the data site on map.

Decide what type of road damage are you dealing with and assign the right road repair team for the task.

**Create Detailed Reports**

Create custom reports about work orders, submissions, unfinished and finished works, work efficiency reports etc. for different periods of time.
Export detailed reports in PDF or excel.

### Submission report

<table>
<thead>
<tr>
<th>ID</th>
<th>Submitted by</th>
<th>Category</th>
<th>Submission time</th>
<th>Forwarded</th>
<th>Forwarding type</th>
<th>Time</th>
<th>Solved on the field</th>
</tr>
</thead>
<tbody>
<tr>
<td>10516</td>
<td>NC 2 - Zlamešić</td>
<td>Zimska služba/Ostalo</td>
<td>10/07/2012</td>
<td>Zimska-Doljave/Gorlša</td>
<td>Email</td>
<td>10/07/2012</td>
<td></td>
</tr>
<tr>
<td>10515</td>
<td>NC 2 - Zlamešić</td>
<td>Zimska služba/Ostalo</td>
<td>10/07/2012</td>
<td>Zimska-Doljave/Gorlša</td>
<td>Email</td>
<td>10/07/2012</td>
<td></td>
</tr>
<tr>
<td>10514</td>
<td>NC 4 - N. Pjović</td>
<td>Signalizacija/Vrtikalna</td>
<td>10/07/2012</td>
<td>Nedecostanja IV/Andreš Bilić</td>
<td>Email</td>
<td>10/07/2012</td>
<td></td>
</tr>
</tbody>
</table>

### Create Work Orders

Finally you can create a work order that's based on visualization, analysis and decisions you've made when processing data. When you’re finished with creating a work order simply forward it to the assigned team. Also, you can print work orders or just export them to PDF for storage or further usage.

Additionally you can forward records via email to other teams, partners etc. In that way you can know exactly who is responsible person for each record because every record is being logged.
<table>
<thead>
<tr>
<th>Type</th>
<th>Forwarded</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td>RJ Signalizacija/Hrvoje Banović</td>
<td>10/07/2012 13:34:30</td>
</tr>
<tr>
<td></td>
<td>Fra Grge Martića</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>Nadcestarija IV/Anđela Bilić</td>
<td>10/07/2012 13:34:36</td>
</tr>
<tr>
<td></td>
<td>Fra Grge Martića</td>
<td></td>
</tr>
</tbody>
</table>
Advanced Options

- Connect to the Map Editor
- Integrate with the Roadwork Management and Coordination
- Integrate with the Fleet Management

Connect to the Map Editor

You can connect Asset Data Collection and Management to the Map Editor to visualize, analyse, share and publish your data.

1. **Define the visual settings of your layers:**
   - Classification by attributes
   - appearance settings
   - attributes settings
   - display settings
   - labels

2. **Analyse your data:**
   - area analysis
   - buffer analysis
   - two layer comparison
   - hotspot analysis
3. Spatial selection

Learn more about:

- Layers Properties
- GIS analysis
- Selecting Layers and Objects

Share and publish your work orders, projects and maps:

- map sharing
- set layer permissions
- embedding maps into a web page
- web map service – WMS

Learn more about:

- Share and Publish

Integrate with the Roadwork Management and Coordination

You can integrate these applications for better managing assets by:
• utilization of already processed data about road damages and traffic signalization
• locating previous, current and future road repairs
• coordinating and planning future roadworks and damaged road repairs etc.

Integrate with the Fleet Management

Integrate with the Fleet Management to:

• coordinate and monitor your workers
• coordinate your fleet for road repair
• analyse fuel consumption, speed etc.
• guide workers with GPS to a located damaged road etc.
Tutorial: Get started

Welcome to the Asset Data Collection and Management. In this tutorial you can get acquainted with the basics and learn more about what you can do with this application.

Add mobile device

First you have to add your mobile devices to the Asset Data Collection and Management so you could instantly send data from your mobile phone to the application. For collecting data on site you need the Mobile Data Collection app installed on your mobile phone.

1. Click on the Home tab.
2. Click on the Add mobile device button.
3. Type in your device ID that you can find in your Mobile Data Collection app you’ve installed on your mobile device.
4. Send data with your mobile device and data will be instantly sent to your Asset Data Collection and Management and will be visible in the Data Table.
5. Click on the Mobile devices button and click Add new.
6. Double click under the Device ID column, type the device ID of your mobile device and press enter.
7. Type in the name of the owner of that mobile device under the First name/Last name column and add any desired comments.
8. Click OK, close and refresh . In the data table, under the "Submitted by column", you can see the name you've entered instead of the device ID.

### Define Partners

Partners are people or organizations to whom you will forward your processed submission (for example if your working with road damages your partners will be various construction organizations responsible for road repairs.)

1. Click on the Partners button.
2. Click Add new, double click under the Organization column, type the name of your partner and press enter.
3. Repeat the process for all of the columns and click OK button.
4. You can add any number of partners depending on your needs.

### Process data

1. You can start processing data by reviewing media and forwarding.
2. Double click on the button in the data table to open submission. Here you can view general info about the date of submission, address and category.
3. Click in the comment box if you want add comments.
4. Click on the Open media button to review photos and audios you sent with your Mobile Data Collection app.
5. Set forwarding type and choose Partner from a list of partners you've created before.
6. Click Forward.
Create a report

You can Create custom reports about submission's number, time, category etc.

1. Click on the Report button.
2. Choose for which time period you wish to create a report and click Show report.
3. You will get report in excel that you can save to your computer.
Fleet Management Manual

This user manual contains all information about the Fleet Management system features. Described functionality followed with images from the application introduces users in a simple way to all features.

- Introducing Fleet Management
- My Account
- Main User Interface
- Manage Your Fleet

Introducing Fleet Management

What is Fleet Management?

GIS Cloud Fleet Management is all in one, simple yet powerful web system helping your company fully exploit the economic benefit of a fleet management solution. Taking your enterprise operations as a whole, GIS Cloud Fleet Management doesn't just reduces fuel cost and eliminate time-wasting unauthorized and unnecessary stops; integrating it to your business systems helps you increase overall efficiency and oversee your company business processes.
Why Fleet Management?

Real time fleet tracking

- Tracking GPS devices from various vendors (Teltonika, Enfora, ...)
- Available API for custom tracking
- Real-time location, time, sensor and other information

Reports

- Daily, monthly and annual time & distance reports
- Eco drive
- Working hours
- Filtering against date, day of a week, time of day, custom labels
- Showing parameters: speed, odometer, RPM, fuel level and any other digital or analog sensor

Driver to Driver & Dispatcher Communication

- Two-way communications between vehicles
- Two-way communications between a vehicle and a dispatcher center
- Integrated with Garmin PNDs and custom terminal devices
- Options for custom form, messages and data transfer
My Account

Before you get started you have to create a new account through our sign up form or sign in instantly with the social network you use.

Sign Up

Create a new account:

Username
Email
Password
Confirm Password

... or sign in instantly with:

Already have an account?

Username
Password

The My Account dialog allows you to edit your personal information and login information.
Main User Interface

In this manual, we have placed a red number over each pictured interface; that number corresponds to the instructions for each product feature.

When you login to your account you will access main Fleet Management interface where you can track vehicles activities and movements and follow all driving parameters and access reports. Interface is very simple and intuitive. It can be divided in 6 sections according to main functionalities you need to know so vehicle fleet could be efficiently tracked:

1. **Log in and My Account** – You need to log in using your User Name and Password to access Fleet Management app. After that you will be able to use the application fully. After logging in, you will be able to modify your user account.
2. **Tool Ribbon** – Here we offer complete access to the application’s features. The tabs above the ribbon reveal additional tools. Tool Ribbon functions are described in the separate chapter Tool Ribbon.
3. **Toolbar** – Provides the tools needed for basic operations with maps. Toolbar functions are described in the separate chapter Toolbar.
4. **Vehicle Activity Panel** - Vehicle activity panel on the left side of the user interface presents information about your fleet by their activity status.
5. **Graph** - Here you can review data about your fleet such as speed, fuel consumption, RPM etc.
6. **Vehicle Activity Map View** - Central section of the fleet management application is the map view of vehicles. Here you can track your vehicles in real time.
Toolbar

The tools and their functions are:

1. Pan – Enables the user to interactively move the Map View position.
2. Zoom – Left click and drag a rectangular box on the map to define the desired view extend. Zooming can also be achieved by a mouse scroll or by using the slider to the left.
3. Zoom to Full Map Extent
4. Measuring Tool – Interactive display of distances on the Map View. Left clicking will allow distance display over multiple vertices.
5. Extend Map - Toggles panel, graph and tool ribbon and extends map view.

Tools Ribbon Overview

Info Tools - All basic information about your vehicles, dates, time, address, satellites and all other basic information you need to manage a fleet.

Tools for Queries - You can easily perform queries and visualize history records on the map. This enables you to have better control over your fleet, drivers and vehicle routes, and to monitor your employees and assignments with more efficiency.

Report Tools - Fleet management reports are very important part of the system which enables you to analyze all necessary information, improve business processes, and reduce unnecessary costs.
**Settings Tools** - Settings tools enables user to edit information about vehicles, labels, drivers and odometer.

**User Tools** - edit information about users and companies, change passwords etc.

**Vehicle Activity Panel**

Vehicle activity panel on the left side of the user interface presents information about your fleet by their activity status.
There are 3 vehicle statuses:

1. **Active vehicles** - Vehicles that are on the movement are grouped and their status is Active. All their activity can be tracked on the map and all necessary driving parameters information on the Info panel.

2. **Stopped vehicles** - Vehicles that are inactive for more than couple of minutes will have the status Stopped.

3. **Inactive vehicle** - Vehicles that stopped and didn’t move for over an hour become inactive vehicles. Vehicles also can be flagged Inactive when GPS tracker doesn’t send its position or has lost connection.

In addition, in the Vehicle Activity panel you can find for how long are selected vehicles active or inactive.

**Graph**

The Graph gives you advanced information about:

1. **Vehicle speed on the road** - average speed on the road, where and when the vehicle went at top speed measured on the road, exceeding the speed etc.

2. **Travel cost** - average fuel consumption and when and where was the highest fuel consumption.

3. **Stops** - where and when did the vehicle stop and for how long was he staying inactive.

4. **RPM** - analyse vehicle path by rounds per minute option.

![Graph Image]

You can review above mentioned information for the whole travel or choose to inspect a specific segment of a path. Therefore you can analyse travels through different periods of time.
or choose to examine a part of a path depending on what do you need.

Vehicle Activity Map

Central section of the fleet management application is the map view of vehicles. Here you can track your vehicles in real time.

Each vehicle is visualized by its current activity status:

1. Green – Vehicle is active
2. Blue – Vehicle stopped
3. Grey – Vehicle inactive

Map view enables you to track vehicles marked in different colors according to their status and to view full vehicle trace history. All vehicles activity you can see in real time is recorded into database. Data can be accessed at any time and recording of vehicle trip with full set of information can be viewed.
Manage Your Fleet

- Administer your User Accounts
- Define Settings
- Review Info
- Queries and Graph Analysis
- Create Reports

Administer Your User Accounts

In the User Tools you can define information about the company name, address, e-mail, web page, logo and all other information that is needed for creating reports, printing documents etc.

Also, here you can change your name and password.
Define Settings

Settings tools enables user to edit information about:

**Vehicles** - use on-board GPS device ID to connect with the vehicle in the application. This basic function is very important because it enables vehicle tracing in the first place. Also, you can enter all necessary and relevant information about that vehicle, company and vehicle driver.

**Labels** - create labels and assign them to vehicles depending on their type.

**Drivers** - with this option you are able to create drivers database. This way users can monitor drivers and connect them to the vehicle they are driving.
**Odometer** - is an instrument that indicates distance traveled by a vehicle. It serves as a reference point for calculating distance, fuel consumption, creating reports etc.

![Odometer form](image)

**Review Info**

Review all information about your vehicles, dates, time, address, satellites and all other basic information you need to manage a fleet. Fleet parameters and activities are set by user in user settings.
Queries and Graph Analysis

You can easily perform queries and visualize history records on the map. This enables you to have better control over your fleet, drivers, vehicle routes, and to monitor your employees and assignments with more efficiency.

Queries can be performed by time and date for selected vehicle. When selected, you can see all vehicle activities in the chosen period of time and follow vehicle route on the map. You can perform queries by following these steps:

1. Select vehicle on the Vehicle Activity Panel.
2. Define time period for which you wish to perform query by selecting dates and entering time of the beginning and the end of the drive.
3. Routes are visualized on the map with marked spots that represent vehicle stops. All vehicle information for this period is also shown numerically.
4. You can keep track of all the vehicles that were driving along the visualized routes by using a recording option. With that option you can follow a specific vehicle along its path.
5. Also, when you perform a query you will see the graph at the bottom of your screen. The graphs shows you data about selected vehicle (see Main User Interface/Graph).
Create Reports

Fleet management reports are very important part of the system which enables you to analyze all necessary information, improve business processes, and reduce unnecessary costs.

There are two main types of reports available:

1. Regular reports
2. Eco reports

Custom Reports

With these reports you can get any information about speed, fuel consumption, vehicles etc. for any time period. You can define these parameters when creating reports:

1. **Report Content** – what data you want to have in your report (max speed, traveled distance, speed exceeding etc.)
2. **Label and Vehicle** – what vehicles and labels will be included in the report.
3. **Date/Time Limits** – you can create daily, monthly and custom reports
4. **Days of week** – define what days of week will be included in the report. For example you can create a weekend report to see how much fuel was spent on off-duty days.
5. **Time of day** - define what part of the day will be included in the report. For example you can create a report that will show you how much fuel was spent in between 3 pm and 9 pm.
After you’ve defined all parameters add your e-mail address and report will be sent to your mail.

Notification email

Request report

(If left blank, default email is used)

Also you can review and download all other reports that were previously created.

An example of created report:
Eco Reports

Ecodriving represents a new driving culture that makes best use of advanced vehicle technologies, while improving road safety. An important component of sustainable mobility, Ecodriving considerably contributes to climate protection and pollution reduction. Eco reports are basically predefined reports that show which drivers are driving in a smarter and more fuel-efficient way. You can create eco reports for different time periods.

**Report content**

Predefined_eco_report

---

<table>
<thead>
<tr>
<th>Vožilo</th>
<th>Početak (vrijeme)</th>
<th>Kraj (vrijeme)</th>
<th>Vrijeme vožnje</th>
<th>Prijeđeni put (Km)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 00:11:35</td>
<td>12/07/2012 07:51:36</td>
<td>7h 40min 1s</td>
<td>0,18</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 07:52:02</td>
<td>12/07/2012 07:53:04</td>
<td>1min 2s</td>
<td>0,35</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 07:54:06</td>
<td>12/07/2012 08:05:04</td>
<td>10min 58s</td>
<td>2,97</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 08:08:55</td>
<td>12/07/2012 10:10:55</td>
<td>2h 2min 0s</td>
<td>0,34</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 10:27:47</td>
<td>12/07/2012 10:39:30</td>
<td>11min 43s</td>
<td>0,51</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 10:39:44</td>
<td>12/07/2012 11:40:47</td>
<td>1h 1min 3s</td>
<td>0,33</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 11:50:58</td>
<td>12/07/2012 11:52:15</td>
<td>1min 17s</td>
<td>0,33</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 11:53:28</td>
<td>12/07/2012 12:05:44</td>
<td>12min 16s</td>
<td>2,18</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 12:05:47</td>
<td>12/07/2012 12:05:44</td>
<td>50min 40s</td>
<td>0,01</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 12:56:32</td>
<td>12/07/2012 13:17:35</td>
<td>2min 3s</td>
<td>0,01</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 13:29:19</td>
<td>12/07/2012 16:30:23</td>
<td>3h 1min 4s</td>
<td>0</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 16:35:51</td>
<td>12/07/2012 16:55:15</td>
<td>19min 24s</td>
<td>4,93</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 16:58:45</td>
<td>12/07/2012 17:09:26</td>
<td>10min 41s</td>
<td>0,03</td>
</tr>
<tr>
<td>Teltonika ZG</td>
<td>12/07/2012 17:30:36</td>
<td>12/07/2012 17:30:36</td>
<td>0s</td>
<td>0</td>
</tr>
</tbody>
</table>

**Summary:**

16h 12min 3s  16,44

After you’ve defined all parameters add your e-mail address and report will be sent to your mail.
Review and download all other reports that were previously created.

<table>
<thead>
<tr>
<th>Type</th>
<th>Requested on</th>
<th>Processed on</th>
<th>Status</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eco report</td>
<td>Jul 14, 2012 10:40</td>
<td></td>
<td>Pending</td>
<td></td>
</tr>
<tr>
<td>GeoTrag report</td>
<td>Jul 12, 2012 17:40</td>
<td>Jul 12, 2012 17:41</td>
<td>Finished</td>
<td>Download</td>
</tr>
<tr>
<td>GeoTrag report</td>
<td>Jul 10, 2012 10:36</td>
<td>Jul 10, 2012 10:37</td>
<td>Finished</td>
<td>Download</td>
</tr>
</tbody>
</table>

An example of a created eco report:
Advanced Options

- Driver to Driver & Dispatcher Communication
- Automatic Tasks and Routing
- Connect to the Map Editor

Driver to Driver & Dispatcher Communication

Two-way messaging is the best way to establish communication between a dispatcher and a driver and between two drivers. Fleet dispatcher can simply send a message to any in-vehicle GPS device. All he needs to do is select vehicle from a list, write a message in the text box and select Send. Driver receives message within seconds and can easily reply with all necessary information. Message templates can be prepared for in-vehicle device thus making driver usage short and more secure.
Automatic Tasks and Routing

You can use Fleet Management for swift and efficient interventions to decrease time of intervention and increase risk management.

For example, fire departments can use this system for quick interventions:

- Operator in call center receives a call and collects all necessary information.
- To send firemen to an intervention he selects a vehicle and selects a location from the map or types in the address of the incident.
- In the text box he can enter the relevant fire information and send message to selected vehicle.
- In-vehicle GPS device receives a message with the coordinates and automatically navigates the driver to the designated location.
- Message inbox is the storage for all messages sent with basic information.
Connect to the Map Editor

You can connect Fleet Management to the Map Editor to visualize, analyse, share and publish your data.

1. **Define the visual settings of your layers:**
   - Classification by attributes
   - appearance settings
   - attributes settings
   - display settings
   - labels
2. **Analyse your data:**
   - area analysis
   - buffer analysis
   - two layer comparison
   - hotspot analysis
   - radius coverage
3. **Spatial selection**
Learn more about:

- Layers properties
- GIS analysis
- Selecting Layers and Objects

**Share and publish your work orders, projects and maps:**

- map sharing
- set layer permissions
- embedding maps into a web page
- web map service – WMS

Learn more about:

- Share and Publish
Roadwork Management and Coordination Manual

This user manual contains all information about the Roadwork Management and Coordination system features. Described functionality followed with images from the application introduces users in a simple way to all features.

- Introduction
- My Account
- Main User Interface
- How Does It Work?

Introducing Roadwork Management and Coordination

What is Roadwork Management and Coordination?

Enables organizations to track their current and planned roadworks projects, and coordinate across agencies to minimize re-work and the resulting traffic disruptions. There is nothing more frustrating to a municipality and the public than to see a road torn up over and over again to address scheduled utility repairs. The real cost of these roadwork projects can include increased traffic congestion, greater pavement deterioration, and ultimately shortened lifespan of the roadway itself. This application can help municipalities and multiple utility agencies to easily coordinate and collaborate on needed and scheduled maintenance projects, and even publish the information to the public to keep them informed of expected delays.
Why Roadwork Management and Coordination?

Custom Asset

- Ability to load various utility locations and networks to identify opportunities to collaborate
- Cross-organization and utility coordination to minimize rework
- Detailed custom form that populates asset information
- Each asset has multiple time checkpoints
- Form and table editors
- Time related map symbology

Timeline analysis

- Date and time coded information of planned projects to coordinate needed roadwork.
- Interactive timeline for moving back&forth in time
- Optimized and fast rendering

Detailed reporting

- Daily, monthly and annual asset reports
- General daily report
- Table view
- Export to Excel
- Integrated report for field workers
My Account

Before you get started you have to create a new account through our sign up form or sign up instantly with the social network you use.

Sign Up

Create a new account:

Username
Email
Password
Confirm Password

Get a Free Account

Already have an account?

Username
Password

Sign In
The My Account dialog allows you to edit your personal information and login information.
Main User Interface

In this manual, we have placed a red number over each pictured interface; that number corresponds to the instructions for each product feature.

1. **Log in and My Account** – You need to log in using your User Name and Password to access Roadwork Management app. After that you will be able to use the application fully. After logging in, you will be able to modify your user account.

2. **Tool Ribbon** – Here we offer complete access to the application’s features. The tabs above the ribbon reveal additional tools. Tool Ribbon functions are described in the separate chapter Tool Ribbon.

3. **Toolbar** – Provides the tools needed for basic operations with maps. Toolbar functions are described in the separate chapter Toolbar.

4. **Info panel** – Displays information of a selected feature.

5. **Layer panel** – A “table of contents” type of display for the active project. The layer panel offers the following functionality:
   - Drag and drop ordering – Control layer display order.
   - Lock layers – Prevent editing and deletion.
   - Layer visibility – Toggles the display of the selected layer.
   - Transparency (bottom) – Transparency of the selected layer increases as slider is moved to the left.
   - Toolbar – Buttons include the following functions for the selected layer:
     - Zoom to selected layer extent

6. **Data Table** – display of entered roadworks.

7. **Map Viewer** – Map display of visible layers and cartographic features.
For better viewing experience we’ve implemented an option to hide tool ribbon and layer panel. The red arrows (on picture below) mark positions of the sliders where you can toggle the ribbon, the layer panel and the info panel on and off.

### Toolbar

The tools and their functions are:

1. **Pan** – Enables the user to interactively move the Map View position.
2. **Zoom** – Left click and drag a rectangular box on the map to define the desired view extend. Zooming can also be achieved by a mouse scroll or by using the slider to the left.
3. **Zoom to Full Map Extent**
4. **Select** – Selects a single feature in an active layer.
5. **Identify** – Identifies an element on the map and shows its attribute information.
6. **Area Selection** – Clicking and dragging a rectangular box with the mouse creates a selected set of features from an active layer.
7. **Measuring Tool** – Interactive display of distances on the Map View. Left clicking will allow distance display over multiple vertices..
8. **Print** – Any created map can be printed.
9. **Scale**
10. **Jump to Coordinates** – Zoom to a set of coordinates – The current coordinates of the mouse cursor are displayed. To define specific coordinates and have the view zoom to the specified position, left click; enter coordinate information.

11. **Number of Selected Objects on the Map**

**Tools Ribbon Overview**

Tool Ribbon provides you with clear view of all tools within their categories. Easy access to tools through the ribbon allows you to use Roadworks Management more efficiently. The following is a brief overview of the tools on the ribbon; a more detailed description of the tools will follow.

**Home Tab** - tools for adding new assets, deleting existing ones and creating reports.

![Home Tab](image)

**Tables Tab** - tools for defining values that are allowed in a field in a form or a table.

![Tables Tab](image)

**Timeline Tab** - for viewing assets through different periods of time.

![Timeline Tab](image)

**Layers Panel**

The Layers panel shows all of the layers of a selected project. The Layer panel also functions as a legend. The following cartographic options are available:
1. **Eye Icon** – Toggles layer visibly on or off.
2. **Transparency Slider** - Slider for setting the transparency of the currently selected layer.
3. **Adjust layer** appearance on the map. Drag layers to set their display order.
4. **Lock layer** – Layers can’t be edited.
5. **Layer Panel Toolbar**

1. **application date**
2. **date of commencement of work**
3. **work in progress**
4. **handover date**
5. **project ended**

**Info Panel**

In the Info Panel you can view attributes and find additional info about a feature you've selected.
Data Table

In the Data Table you can view and edit attributes of all features you have entered. Every entered construction gets his own ID that is automatically assigned when you create a construction.

<table>
<thead>
<tr>
<th>ID</th>
<th>Case Applicant</th>
<th>Contractor</th>
<th>Place of work</th>
<th>Consent</th>
<th>Started</th>
<th>Ended</th>
<th>Checkout</th>
<th>Handover</th>
</tr>
</thead>
<tbody>
<tr>
<td>2012 - 13051 2136</td>
<td>AGROPLAN d.o.o.</td>
<td>AGROPLAN d.o.o.</td>
<td>GRADSKA PLINARA ZAGREB d KUZAČKA 1</td>
<td>11/07/2012</td>
<td>12/07/2012</td>
<td>12/08/2012</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2012 - 13051 2137</td>
<td>Zn d.o.o. VODOPSKBRA I OCV. Zn d.o.o. VODOPSKBRA I OI Zn d.o.o. VODOPSKBRA I OI HUZINOVCA 3</td>
<td>11/07/2012</td>
<td>12/07/2012</td>
<td>12/08/2012</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2012 - 13051 2138</td>
<td>Zn d.o.o. VODOPSKBRA I OCV. Zn d.o.o. VODOPSKBRA I OI Zn d.o.o. VODOPSKBRA I OI HUZINOVCA 3</td>
<td>11/07/2012</td>
<td>12/07/2012</td>
<td>12/08/2012</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2012 - 13051 2139</td>
<td>GRADSKA PLINARA ZAGREB d KUZAČKA 1</td>
<td>GRADSKA PLINARA ZAGREB d KUZAČKA 1</td>
<td>ILICA - BRITANSKI TRG</td>
<td>11/07/2012</td>
<td>12/07/2012</td>
<td>12/08/2012</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

How Does It Work?

- Create Custom Forms and Tables
- Enter a Construction
- Timeline Analysis
- Create Detailed Reports
- Print Related Documents
Create Custom Forms and Tables

You have the option to create a personalized custom made forms and tables in which you will type all the information about your roadworks. For example you can define: the type of a road you are dealing with; are there any damages or future projects planned on the specific road; who will be the constructor; who is the investor; construction dates; legal matters etc. Also, you can define what values are allowed in a field in a form or a table. That option serves as a mechanism for enforcing data integrity necessary for work in multiuser environment.
Enter a Construction

After you've created and customized forms and tables you can start entering constructions. First step is to fill out all the forms and tables with the necessary information.

After that you have to define the location of an entered construction.
All entered constructions are shown in the data table with assigned ID’s.

<table>
<thead>
<tr>
<th>ID</th>
<th>Consec</th>
<th>Applicant</th>
<th>Investor</th>
<th>Contractor</th>
<th>Place of work</th>
</tr>
</thead>
<tbody>
<tr>
<td>2012-13056</td>
<td>2156</td>
<td>T.D.D.GRADNJA d.o.o.</td>
<td>T.D.D. GRADNJA d.o.o.</td>
<td>ZH d.o.o. VODOOPSKRBA I OI KRAPANSKA 23/1 - M</td>
<td></td>
</tr>
<tr>
<td>2012-13056</td>
<td>2142</td>
<td>AGROPLAN d.o.o.</td>
<td>AGROPLAN d.o.o.</td>
<td>GRADSKA PLINARA ZAGREB d KUPJAČKA 1</td>
<td></td>
</tr>
</tbody>
</table>

Timeline analysis

With the Timeline you can visualize dynamic data through period of time. You can use it to see the duration of the past and current works, monitor and evaluate progress, plan next projects, coordinate current and future roadworks etc. Roadwork progress through a period of one month:

5/25/2012
Create Detailed Reports

Create custom reports about roadwork's number, location, attributes, progress etc. for different periods of time.

Example of a created report:

<table>
<thead>
<tr>
<th>Consent</th>
<th>Investor</th>
<th>Objective</th>
<th>Address</th>
<th>Long</th>
</tr>
</thead>
<tbody>
<tr>
<td>2156</td>
<td>T.D.D. GRADNJA d.o.o.</td>
<td>PRIKLJUČAK VODE</td>
<td>KRAPANJSKA 23/1 - MACANOVIĆA HRVOJA</td>
<td>15.9255</td>
</tr>
<tr>
<td>2142</td>
<td>AGROPLAN d.o.o.</td>
<td>PRIKLJUČAK PLUNA</td>
<td>KUPJAČKA 1</td>
<td>15.9221</td>
</tr>
<tr>
<td>2166</td>
<td>ZH d.o.o. VODOPSKRBA I ODVODNJA</td>
<td>POPRAVAK VODOVODA</td>
<td>GRAŠČICA 15</td>
<td>15.9684</td>
</tr>
<tr>
<td>2157</td>
<td>ZH d.o.o. VODOPSKRBA I ODVODNJA</td>
<td>PRIKLJUČAK VODE</td>
<td>HUZIKA 3</td>
<td>15.8685</td>
</tr>
</tbody>
</table>

Print Related Documents

After you've entered and processed all the roadworks you can create important documents with all the previously entered data that are needed for further roadwork process. For example, you may need official documents such as legal permits, insurance applications, handover records etc. to continue road construction. All created documents can be printed or exported in PDF or Excel for storage or further usage.
Poziv na primopredaju
Primopredajni zapisnik
Zahtjev za osiguranje
Advanced Options

- Connect to the Map Editor
- Integrate with the Asset Data Collection and Management
- Integrate with the Fleet Management
- Connect with the Mobile Data Collection

Connect to the Map Editor

You can connect Roadworks Management and Coordination app to the Map Editor to visualize, analyse, share and publish your data.

1. **Define the visual settings of your layers:**
   - Classification by attributes
   - appearance settings
   - attributes settings
   - display settings
   - labels

2. **Analyse your data:**
   - area analysis
   - buffer analysis
   - two layer comparison
3. Spatial selection

Learn more about:

- Layers properties
- GIS analysis
- Selecting Layers and Objects

Share and publish your work orders, projects and maps:

- map sharing
- set layer permissions
- embedding maps into a web page
- web map service – WMS

Learn more about:

- Share and Publish
Integrate with the Asset Data Collection and Management

You can integrate these applications for better managing roadworks by:

- utilization of already processed data about road damages and traffic signalization
- locating previous, current and future road repairs
- coordinating and planning future roadworks and damaged road repairs etc.

Integrate with the Fleet Management

Integrate with the Fleet Management to:

- coordinate and monitor your workers
- plan routes for transporting materials
- coordinate your fleet for road repair and construction
- analyse fuel consumption, speed etc.
Connect with the Mobile Data Collection app

Gather and locate data on site to send photos, audio records and comments directly to the Roadworks Management and Coordination app in real time.
Tutorial: Get started

Welcome to the Roadwork Management and Coordination Application. In this tutorial you can get acquainted with the basics and learn more about what you can do with this application.

Define Tables

First you have to fill out all the forms and tables to predefine what values can be selected in the construction's attribute table when entering a construction.

1. Click on the Tables tab.
2. Select the Investor option to define all the investors that could be a part of a Roadwork project.
   - Click Add new button and double click under the Name column.
   - Type the name of the investor and press enter.
   - Repeat the process for all of the columns and click OK button
   - You can add any number of investors depending on your needs.
3. Repeat the process for all of the tables and forms. To find more information about tables and forms click: Tables Tab Explanation.

Enter a construction

After you've defined all the values you can start entering constructions.

1. Click on the Home tab.
2. Click on the New Construction button. Here you can enter information about application, offer, consent, invoice etc. To define information about an application click on the Application tab.
   - Define the applicant by selecting it from a list you've created in the Tables tab.
   - Set the application date.
   - Set the Adress (location) of your construction:
     - Enter a geocoded address
     - Manually click on the map with the cursor
     - Select location from the mobile report (when integrated with the Asset Data Collection and Management)
     - Define longitude and latitude
   - Define all the values needed in the Application part of a construction.
   - Define all the values in all of the construction tabs. To find more information about construction tabs click Construction Tabs Explanation.
3. You can create as many constructions as you want.
Create a report

You can Create custom reports about roadwork’s number, location, attributes, progress etc. for different periods of time.

1. Click on the Report button.
2. Choose for which time period you wish to create a report and click Show report.
3. You will get report in excel that you can save to your computer.

Timeline analysis

With the Timeline you can visualize dynamic data through period of time.

1. Click on the Timeline tab.
2. Move slide bars to set the desired time period you wish to analyse
3. For more information about timeline click Timeline analysis.

Tables Tab Explanation

Investor - a list of investors you are working with.
Applicant - a list of people or organizations that are applying for a new road construction.
Responsible person - a list of people responsible for receiving and forwarding applications.
RS Responsible person - a list of people for receiving and forwarding applications but with limited or specified options.
Contractor - a list of contractors you are working with.
Districts - a list of locations (town districts, suburbs etc.) on which you have permit to construct.
Services - a list of services responsible for road construction.
Road category - a list of road categories (public road, state road, unsorted road etc.).
Objectives - purpose of a road construction (road construction after: sewer repair, pipeline deploy, public lighting maintenance, setting light/electric poles etc.).
Construction Tabs Explanation

Mark - application mark serves for better archiving of your applications.
Application date - define the date by selecting it on the calendar. All other options in the Application tab are explained in the Tables tab explanation.
### Construction

<table>
<thead>
<tr>
<th>Application</th>
<th>Offer</th>
<th>Consent</th>
<th>Checkout</th>
<th>Handover</th>
<th>Recovery</th>
<th>Invoice</th>
<th>Mobile</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Road area m² - pavement area.
#### Footpath area m² - footpath area for pedestrians.
#### Pieces - number of roads that need to be constructed.
#### Price - construction price.

<table>
<thead>
<tr>
<th>Date of consent</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Consent</td>
<td></td>
</tr>
<tr>
<td>Class</td>
<td></td>
</tr>
<tr>
<td>Reference number</td>
<td></td>
</tr>
<tr>
<td>Started</td>
<td></td>
</tr>
<tr>
<td>Ended</td>
<td></td>
</tr>
<tr>
<td>Prolonged</td>
<td></td>
</tr>
</tbody>
</table>

#### Number of consent, Class and reference number - serves for better archiving your consent.
#### Started - date of commencement of work.
#### Ended - planned completion date.
#### Prolonged - use this option when for works that are prolonged.
When the works are done you have to check out those works by defining: the checkout date, duration of works, the person who’s responsible for checkout.

**Handover date and person responsible.**

Set the date of repair if needed.
With this option you can manage the financial part of the construction.

Use this option to integrate with the Asset Data Collection and Management.

Type any comments regarding your constructions.
Mobile Data Collection

Collect Location

- Real-time GPS location
- Precision up-to 5 meters

Collect Multimedia

- Image support
- Audio support

Collecting data off-site has never been easier. With GIS Cloud Mobile Data Collection, all you need is a few taps of the finger and you have media enriched location information available from anywhere. You are simply populating data into a map layer created in GIS Cloud in real time and data can immediately be analyzed, shared and published.
Collect points and assign images and audio to them as attributes - it is as simple as that. Cloud based solution for data management enables an up-to-date database available to off-site workers, in the office or to the management at the same time making day to day tasks more fluid and organized.

**How to use Mobile Data Collection app**

Your location is shown as GPS coordinates. You can take a look by expanding the Location menu. Please wait for the GPS to initialize after which the app will register your location. The accuracy will increase depending on satellite availability. To collect an image and associate it with collected data you just have to **Take a photo** in the Photos menu. Tap **Record** in the Recording menu to record an audio message. You can **Play** back the recorded message to check if you have captured the necessary information and **Delete** it if you didn’t do it right the first time. Finally, you can add a **Comment** as a text attribute. Once you have collected all the data, you just have to **Send** it to GIS Cloud layer and that’s it. Data can be accessed in GIS Cloud immediately. Enjoy using GIS Cloud Mobile Data Collection!
Publisher for ArcMap

The GIS Cloud Publisher for ArcMap extension enables you to publish your maps from ArcMap to GIS Cloud with only one click. It automatically uploads your data, symbology, layer structure and spatial references. The idea is that what you see in your desktop GIS is instantly replicated on your GIS Cloud account. Once your maps and data are on GIS Cloud, they are easily published to the public or embedded into your website/blog without a need for having your own servers.

Publish Maps, Layers and Data

- Secure SSL connection to GIS Cloud
- Choose which layers to export
- Support for create and update
- Vector data can be uploaded, regardless of the datasource

Transfer Symbology

- Point layer symbology support almost at 100%
- Simple line symbols – only solid lines
- Simple fill symbols – only single color fills
- Unique value categories or graduated color symbology
- Labels

The extension has been made highly compatible and should work with any ArcGIS 9.x and 10.0+. You can download it from the following link: GIS Cloud Publisher for ArcMap (600kB) A map in ESRI ArcMap:
Open the GIS Cloud Publisher extension. And with one click publish your map. The name of your map in GIS Cloud will be the same as the name of your project in ArcMap. If you want to publish multiple projects to GIS Cloud without overwriting those you've already published simply don’t check Overwrite existing map check box. Also, you have an option to separately publish symbols or data of your project in case you've already uploaded your project but you've made some minor changes and wish to publish only those changes.

Your desktop map published in GIS Cloud:
FAQ

Frequently Asked Questions

- GIS Cloud Applications
- Sign Up and Accounts
- Map Editor
- Map Viewer
- Asset Data Collection and Management
- Roadwork Data Management and Coordination
- Fleet Management
- Mobile Data Collection
- GIS Cloud Publisher

GIS Cloud Applications

How many applications have you developed?

- We’ve developed seven applications that you can easily access through your web browser.
- Click here to see the full list of the applications we offer.

Do I need to install any of the applications?

- All apps are instantly available and users can get started with them in a matter of seconds. No more IT, no more CD installations, no more desktop & server software!

Who can use these applications?

- Everybody can sign up and explore all of our applications.
- Whether you’re working in: the environmental industry, local government, the utilities industry, emergency services or you’re a real estate agent, banker, explorer etc. simply sign up to see how you can use these applications to permanently improve your workflow.

GIS Cloud technology?

- GIS Cloud’s main differentiating characteristic is its unique vector visualization engine because it provides a full desktop-like GIS experience in any browser. This improves usability, appearance, mapping experience in a way that other map engines (using raster technology) cannot.
• The cloud provides a reliable, secure and highly available infrastructure which is under constant supervision and management from our team.

What do you mean by saying that some of the applications are in beta?

• At this moment, three of our applications are still in the beta (Fleet Management, Roadworks Management and Coordination and Asset Data Collection and Management) because we want to show the usability of our applications to our users and allow them to use it free of charge for both commercial and non-commercial purposes.
• The only thing we want is your feedback on how to improve all of our applications, so please feel free to suggest, ask, comment or share any thought you might have!

Sign Up and Accounts

What is the non-commercial account for?

• Non-commercial account is for personal, academic use and non-commercial/non-profit purposes only. With non-commercial accounts we want to encourage our users to learn about GIS in the Cloud, help their community with the projects they might have etc.

Why should I sign up for a commercial account?

• With the commercial account you can use all of the options and features we offer for commercial profit purposes. This means storage and sharing rights, editing and analysis tools, map embedding etc.

How many accounts can I create?

• You can create one account per e-mail address.

Can I sign up to all of the applications with just one account?

• Yes! With just one account you can sign up to all of the applications we offer.

Where can I change my password?

• If you wish to change your password simply go to your personal account in the application and change your password.

Where can I see which applications I am subscribed to?
• To see to which applications you are subscribed to, go to your personal account in the application and click on the My Apps option.

Map Editor

Why should I sign up to the Map Editor?

• GIS Cloud’s Map Editor is a powerful cloud based map editor that enables you to easily build and share your maps. It supports number of vector and raster formats, rich GIS symbology and it has built-in collaboration capabilities.
• For more information about Map Editor’s features click here.

Can I upload my data to the Map Editor?

• Yes! Data from a local computer is uploaded using the File Manager.
• For more about the File Manager and data uploading click here.

What kind of data can I upload?

• You can upload:
  1. Spatial Vector files: .shp, .mif, .mid, .tab, .kml, .gpx
  2. Spatial Raster files: .tif, .tiff, .jpg, .gif
  3. Image files: .jpg, .gif, .swf, .png
  4. Excel 2003 and CSV: .csv and .xls

How much data can I upload?

• It depends on what subscription do you have.
• Storage pricing coming soon.

It says that I need to transfer my data to the PostGIS database for my data to be editable?

• If you want to perform analysis or edit data you have to transfer your data to PostGIS database.
• For more information on how to transfer data to PostGIS click here.

Do I need to create my own PostGIS database to be able to transfer my data?

• No, you don’t. Simply click on the database manager and import your data.
How can I transfer my data to PostGIS database?

- To find out how to transfer data to PostGIS database click here.

Can I create and edit layers in the Map Editor?

- Of course!
- For more information about layer creating and editing click here.

Can I connect my mobile device to the Map Editor?

- Yes, you have the option to create mobile layer in the Map Editor that will contain data sent from the Mobile Data Collection application.
- For more information about creating mobile layers click here.

Are there any analysis tools that I can use?

- In the Map Editor application you can find several tools for GIS analysis.
- For more information about GIS analysis tools click here.

Can I share my maps to other users?

- GIS Cloud has several options for sharing and publishing data.
- For more information about sharing and publishing click here.

How can I allow someone to export my layers?

- To allow other Map Editor and Map Viewer users to export layers from your maps simply add those users in the sharing options of your map and give them privilege to edit (View is just for viewing).
- Additionally, all layers are set as exportable by default but you can change this in the Layer permissions tab of your map.

Can I embed my maps into my website?

- Map Editor enables you to embed every map you create into your website.
- For more information about Map embedding click here.

Can I share my map as a WMS?

- Yes!
- For more information about WMS click here.
Can I share maps to users that are only signed to the Map Viewer application?

- Yes, you can share your maps to every GIS Cloud user that has a subscription to at least one of our applications.

Are there any tutorials that I can use to get better acquainted with the Map Editor?

- You can access Map Editor tutorials here.
- Feel free to share us your thoughts about what should be the next tutorial or what part of the manual should be better explained.

Is there some kind of user manual I can use?

- You can access GIS Cloud User Manual here.
- We are constantly updating the GIS Cloud User Manual with the new materials in terms of new tutorials, examples etc. so please feel free to comment or suggest what should be better explained.

Map Viewer

Why should I sign up to the Map Viewer?

- An easy way to view and access maps and data.
- Optimized for non-professionals that need a simple and easy way to access maps and geospatial content.
- For more information about Map Viewer’s features click here.

What maps can I view in the Map Viewer?

- In the Map Viewer you can view all maps you’ve created in the Map Editor application (if you have a subscription), maps that other users shared with you and public maps.

Can I print maps?

- All maps that you can access can be printed for further usage.

Can I export layers from maps that other users have created?

- You can export only those layers for which you have the permission to download.
- Every map owner decides what layers he wants to share and who will have the permission for exporting.
What tools can I use?

- Map Viewer enables you to interactively view and explore dynamic maps, share and export data you need for your work, perform basic selecting queries by attributes or location for simple data analysis and visualization, print maps, data table viewing, search features of your interest etc.
- For more information about tools in Map Viewer click here.

Is there some kind of user manual I can use?

- You can access GIS Cloud User Manual here.
- We are constantly updating the GIS Cloud User Manual with the new materials in terms of new tutorials, examples etc. so please feel free to comment or suggest what should be better explained.

Asset Data Collection and Management

Why should I sign up to the Asset Data Collection and Management?

- Asset Data Collection and Management is a simple and easy to use system for managing your on field collected data in real time.
- For more information about Asset Data Collection and Management and its features click here.

What is the price?

- The application is in beta and therefore free of charge so please feel free to test, explore and use it for non-commercial and commercial purposes.
- The only thing we want is your feedback on how to improve the application so any suggestion, question, comment or thought would be much appreciated!

How can I connect my mobile device to the Asset Data Collection and Management?

- To connect your mobile device to the application first you have to download and install the Mobile Data Collection application on your mobile device. After that simply associate your mobile device to your Asset Data Collection and Management.
- For more information about associating mobile devices click here.

How many mobile devices can I connect to the application?

- You can connect as many mobile devices as you like.
Can I create my own custom forms in the Asset Data Collection and Management?

- At this moment you can’t create your own custom forms but if you have such needs feel free to contact us for more information about developing your own customized Asset Data Collection and Management.

Can I develop my own customized version of Asset Data Collection and Management?

- That would be great!
- One of our goals is to show and teach others how to create their own application that will suit their needs. If you have more questions on how to develop your own application based on GIS Cloud platform please contact us at info@giscloud.com.

Can I share my data/map to other users?

- You can view and edit your Asset Data Collection and Management in your Map Editor application (if you have a subscription).
- In the Map Editor you can share your Asset map to other users.

Are there any tutorials I can use to get better acquainted with the application?

- You can access Asset Data Collection and Management tutorial here.
- Feel free to share us your thoughts about what should be the next tutorial or what part of the manual should be better explained.

Is there some kind of user manual I can use?

- You can access GIS Cloud User Manual here.
- We are constantly updating the GIS Cloud User Manual with the new materials in terms of new tutorials, examples etc. so please feel free to comment or suggest what should be better explained.

Roadwork Data Management and Coordination

Why should I sign up to the Roadwork Management and Coordination?

- Enables organizations to track their current and planned roadworks projects, and coordinate across agencies to minimize re-work and the resulting traffic disruptions.
- For more information about Roadwork Management and Coordination and its features click here.
What is the price?

- The application is in beta and therefore free of charge so please feel free to test, explore and use it for non-commercial and commercial purposes.
- The only thing we want is your feedback on how to improve the application so any suggestion, question, comment or thought would be much appreciated!

Can I create my own custom forms and tables in the Roadwork Management and Coordination?

- At this moment you can’t create your own custom forms but if you have such needs feel free to contact us for more information about developing your own customized Roadwork Management and Coordination.

Can I develop my own customized version of Roadwork Management and Coordination?

- That would be great!
- One of our goals is to show and teach others how to create their own application that will suit their needs. If you have more questions on how to develop your own application based on GIS Cloud platform please contact us at info@giscloud.com.

Can I share my data/map to the other users?

- You can view and edit your Roadwork Management and Coordination map in your Map Editor application (if you have a subscription).
- In the Map Editor you can share your Roadwork map to other users.

Are there any tutorials I can use to get better acquainted with the application?

- You can access Roadwork Management and Coordination tutorial here.
- Feel free to share us your thoughts about what should be the next tutorial or what part of the manual should be better explained.

Is there some kind of user manual I can use?

- You can access GIS Cloud User Manual here.
- We are constantly updating the GIS Cloud User Manual with the new materials in terms of new tutorials, examples etc. so please feel free to comment or suggest what should be better explained.
Fleet Management

Why should I sign up to the Fleet Management?

- GIS Cloud Fleet Management is all in one, simple yet powerful web system helping your company fully exploit the economic benefit of a fleet management solution.
- For more information about Fleet Management and its features click here.

What is the price?

The application is in beta and therefore free of charge so please feel free to test, explore and use it for non-commercial and commercial purposes. The only thing we want is your feedback on how to improve the application so any suggestion, question, comment or thought would be much appreciated!

Is tracking vehicles in real time?

- Refresh rate in the Fleet Management is exactly 5 seconds which means that the location of your fleet is updating every 5 seconds.

What exactly can I monitor with the application?

- With the Fleet Management you can monitor your vehicle’s location, speed (average, maximum and minimum), RPM, fuel level, traveled distance, time on the on the road and all that in real time.

Can I send messages to the vehicle with the application?

- Fleet Management allows driver to driver and dispatcher communication.
- For more information about messaging click here.

Can I develop my own customized version of the Fleet Management?

- That would be great!
- One of our goals is to show and teach others how to create their own application that will suit their needs. If you have more questions on how to develop your own application based on GIS Cloud platform please contact us at info@giscloud.com.

Can I share my data/map to the other users?

- You can view and edit your Fleet Management map in your Map Editor application (if you have a subscription).
- In the Map Editor you can share your Fleet map to other users.
Is there some kind of user manual I can use?

- You can access GIS Cloud User Manual here.
- We are constantly updating the GIS Cloud User Manual with the new materials in terms of new tutorials, examples etc. so please feel free to comment or suggest what should be better explained.

Mobile Data Collection

Why should I download the Mobile Data Collection App?

- Collecting data off-site has never been easier. With GIS Cloud Mobile Data Collection, all you need is a few taps of the finger and you have media enriched location information available from anywhere.
- For more information about Mobile Data Collection please click here.

What is the price?

- The application is in beta and therefore free of charge so please feel free to test, explore and use it for non-commercial and commercial purposes.
- The only thing we want is your feedback on how to improve the application so any suggestion, question, comment or thought would be much appreciated!

Where can I download the application?

- Download Mobile Data Collection Application

Can I install the application to my iphone?

- At this moment you can install the application only on android but iphone version of application is coming very soon.

Can I gather data when there is no internet connection?

- Unfortunately, at this moment, you can’t use Mobile Data Collection while offline.

Can I send my data to multiple users and applications?

- When you install the application your mobile device automatically gets its own Device ID that you can share to other users who can then associate your mobile device to their application.
Your mobile device can be connected to several accounts and applications and with just one click you can send data to all users at the same time.

GIS Cloud Publisher

Why should I install the GIS Cloud Publisher?

- The GIS Cloud Publisher for ArcMap extension enables you to publish your maps from ArcMap to GIS Cloud with only one click.
- For more information about the GIS Cloud publisher click here.

What is the price?

- The application is completely free and available for download: GIS Cloud Publisher for ArcMap (600kB)